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09.00 - 09.30 . | Basic principles of learning media NALAS.259550 Malvdagydy
09.30 — 11.00 W. | Demonstrate and Workshop: AUNIEIUS AStyRswa HALA3.252550d USRSy
Online screen recording tools: Loom / RecordRTC UNYEYIANT %’muﬁﬂjﬁﬁad

UNNUNNG ANFTUURS

UN.Juing Feimudsng

Aoufila Hana1ms

11.15 - 12.00 W. | Tips for designing visual media UN.Fuins Toiaussing

12.00 - 13.00 4. | suvsenIuemIsTnaINii

13.00 - 14.30 . | Demonstrate and Workshop: UNBYINT Tnufazaes HALA3.252550d USRSy
Infographic makers for creating an infographic: YN.NUANE ANFSUUAS
Piktochart Y

UN UM Fotaussng

Aoufila Hana1ms

14.45 - 16,00 u. | Demonstrate and Workshop: UNBYNT TuRaTaEes HA.AT.2979500 1Ay Ty
Infographic makers for creating an infographic: YWAUNNE ANESULAS
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UN.JUANS ToTmussng

Aoufila nana1ms
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Autila wana1vs
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UN.NUNNA ANFTUWAT

Aauila Hana1ms
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Powtoon un Busns Fofmussng

Aauiila Hana1ms
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WA.AS.ISISSMU DUBHIDSUBY

HOUo : Basic principles of learning media

Basic principles of learning media

daaaAans1anse ag.as9990d 0ndleiaTyde

Audaraniwdadunisdnmineansganm

ANTUNNEAIARTATININEILI NUINLIALNTRA

Cognitive Load Theory

Richard Mayer

Germane load
“generative
processing”

Intrinsic load
“essential
processing”

Extraneous load g
“extraneous
processing”

Principles of Multimedia Learning

* The Coherence Principle

¢ The Signaling Principle

¢ The Redundancy Principle

* The Spatial Contiguity Principle

¢ The Temporal Contiguity Principle

Principles That
Minimize

Extraneous
Load

https://ctl.wiley.com/principles-of-multimedia-learning/

Principles of Multimedia Learning

LTS EENIETSN o The Segmenting Principle
\ENET-LH {9 * The Pre-Training Principle
Load * The Modality Principle

¢ The Multimedia Principle

¢ The Personalization Principle
* The Voice Principle

* The Image Principle

Principles That
Optimize
Germane Load

AUEANUITUIAAAIUMSANKTINGIMERSAVIW (FIFD) ATUEIWNYAARSASS1BWE1UA Tel. 02-4199978, 02-4196637
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The Coherence
Principle

People learn better when
extraneous material is
excluded rather than
included.

Principles That Minimize Extraneous Load

The Signaling
Principle

Principles That Minimize Extraneous Load

People learn better when
cues that highlight the
organization of the essential
material are added.

The Redundancy
Principle

People learn better from
graphics and narration than
some graphics, narration, and
printed text.

Principles That Minimize Extraneous Load

The Spatial
Contiguity
Principle

Principles That Minimize Extraneous Load

Students learn better when
corresponding words and
pictures are presented near
rather than far from each
other on the page or screen.

“ AUgAUITUIAAAUNMSANWINGIMARSIVATW (FIFID) ALUIWNGAIANSASS1BWEIUNa Tel. 02-4199978, 02-4196637
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The Temporal
Contiguity
Principle

Students learn better when
corresponding words and
pictures are presented
simultaneously rather than
successively.

Principles That Minimize Extraneous Load

The Segmenting
Principle

Principles That Manage Intrinsic Load

* People learn better when
a multimedia message is
presented in user-paced
segments rather than as
a continuous unit.

The Pre-Training
Principle

* People learn more deeply
from a multimedia message
when they know the names
and characteristics of the
main concepts.

Principles That Manage Intrinsic Load

The Modality
Principle

Principles That Manage Intrinsic Load

* People learn more deeply

from pictures and spoken
words than from pictures
and printed words.

AUEANUITUIAAAIUMSANKINGIMERSAVNW (FIFD) ATUEIWNYAARSASS1BWEUA Tel. 02-4199978, 02-4196637 —
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* People learn better from
words and pictures than
from words alone.

The Multimedia
Principle

Principles That Optimize Germane Load

* People learn better from

) The multimedia presentations
Personalization when words are in
Principle conversational style rather

than formal style.

Principles That Optimize Germane Load

*People learn better when
narration is spoken in a
human voice rather than in
a machine voice.

The Voice
Principle

Principles That Optimize Germane Load

* People do not necessarily
learn better when the
speaker’s image is added
to the screen.

Principles That Optimize Germane Load

The Image
Principle

n AUEANUITUIAAAUNSANKINGIAERSAVAW (FIFID) ATUEIWNYAARSASS1BWEUa Tel. 02-4199978, 02-4196637
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ONLINE SCREEN RECORDINGTOOLS::

WUNIEWUS A3TGTna

dndmnssnsane gudansidwdemunsinmineensasganim

Software Screen Recorder

BANDICAM .' @ loom
Record Everything on your PC
em

Webex Meetings

Camtasia”

oCai

- n Recorder

".’ Jeecream
HH Bl Screen Recorder

@ Capture video Screenshot

FastStonfé.’éa;iture
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Loom

Hwesasdlatuin VDO vuszvaaulad ffldnmensnsnidanlahasiviindhs Web browser(Extension) va a:
fasdlusunsn Loom asuueasitased lassansnldnuldvis Window uae Mac OS

helerizas Loom
Tgmildte lidasiinss Software fsnsnsaiuiin VDO 1o
samndaniulzelin Cloud et gogn 25 Inid Lsisrian
sanmouss VDO Tisuraulai
samadadauuszuy Cloud e
sansnmvuesvisenNUaanstla

aunsn download sifuliidulnd MP4 e

mweees Loom

Record Notifications Q)

.
Start Recording

AUgAUITUIAAAUNMSANWINEIAMARSAVAW (FIFID) ALIWNGFIANSASS1EWE1U1a Tel. 02-4199978, 02-4196637
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Tunaumsfaes Loom #1

wiulsd www.loom.com war dn Get Loom for Free

€ 4 o (EksE

Oloom

=
Show it, sayit, - il
send it. g

Instantly ready to share and watch anywhere.

Tunaumsfads Loom #2

. . A Ve o s . Sign up for Loom
vims Login lauansnsnifenldazasiasshe Google wio

Start with a fully-featured, 14-day trial of Loom
Slack ‘W%B App|e account W%Bmédﬁﬂﬁ}j@ﬂ@%ﬁﬂ E'mail Business. If you don’t like it, keep using Loom for free,
u < wu yahoo, Hotmail denm

G Sign up with Google

5" Sign up with Slack
Tusaehait rewazld Sign up with Google

@& Sign up with Apple

orsign up with email

Email

Enter your emall...

Create Free Account

Already have an account? Sign In

AUEANUITUIAAAIUMSANKTINGIMERSAVIW (FIFD) ATUEIWNYAARSASS1BWE1UA Tel. 02-4199978, 02-4196637
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Tumaumsfeds Loom #3

e Login éhifaaudig Library sesmues demnidu account Tusl azlsifinems VDO waesliidiu mrilvieandisls
Record a video wiadsmaiuiin usdwsugldnuassusnazdasiadslisunss Loom raw dsazansnsnGumaiuiin VDO 1

‘ .F“efsonal Library

dugaumaiinds Loom #4

Werdnilu Record a video ssuvasliiwdaniasdiods Loom wule lessansaidianiuy
- Desktop App dunws@sdsaszuuiifnseesinges sansadadilaiiun Window OS usz Mac OS

- Chrome Extension diumséess Plugin un Browser google chrome lpgmss &

Whoops! It looks like you need to install the
Chrome Extension to continue.

Also check out how to record with the Desktop App and
Chrome Extension for more details.

IZ', Visit Chrome Store

n AUgAUITUIAAAUNMSANWINEIAMARSAVAW (FIFID) ALIWNGFIANSASS1EWE1U1a Tel. 02-4199978, 02-4196637
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Bmsdauw Loom #1

nmshathadladadoun Desktop app Wedadushisa Tsunssaslivhms
Loginman) 8nesilaels Account #ildlasld e login gsaay

UEAHARIMNGIUA

Bmsdauw Loom #2

Loom

€ loom
Signin
% with Slack

‘ with Apple

& Continue with SSO

Or sign in with email

Email

Sign up

s with Geogle

B3 with Outleck

[ Enter your email

J

Password

Enter your password

Sign in to your account

Forgot password?

wsasfladwsy control agldamldidie
Suneatiin

P d <

naeilidon 4 dhwm fa 2anaudn
P4 A e

2nawlng Avduadsmming uas qulls

Ing

fudamnans s uag shumbsiidaans

v &K
UUnn
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Loom Plans

All Plans

Starter

Quick videos & screenshots

Free

Workspace Limits
25 Creators

+ Unlimited Viewers

/100 videos & screenshots
5 min recording length
Features

 Screen & cam recording
+ Screenshots

+ Team Library

 Viewer Insights

Your Plan

RecordRTC

Business

Advanced recording & analytics

$8 per Creator / month

Workspace Limits
v 100 Greaters

« Unlimited Viewers

 Unlimited videos & screenshots

+ Unlimited recording length
Everything in Starter, plus

+ Video drawing tool

+ Calls-to-action

+ Custom branding

+ Engagement Insights

Upgrade

+ Unlimited videos & screenshots

+ Unlimited recording length

Everything in Business, plus

+ 5CIM (Coming soon ()

Q Billed monthly (@) Billed annually (20% Savings)

Advanced admin, security & integrations

+ Private content (Coming soon &)

+ Salesforce integration (Coming soon!)

#ia Extension @ anwwmuu Google chrome Nam:rmvﬂmmu NImbUS ‘ﬁdﬂ?ﬂﬁﬂ@l@@mm”i‘ﬁﬂum%
Browser GOOgle Chrome vLGW“ﬂ‘LWW mwsnuwnﬂmwmaa NaBY LAY Lﬁm\l@ﬂunammﬂu

seleant

finssheuu Google chrome

wn Sync 13 Gmail 13 mnvims Login fieRasnanfisofinaastu 9 snawhnsdeds Extension

%1‘1/1 Q] WI%N 6l

anansnniuiin leaneana e (Fudw)

asnsoiuiinyiamiiee ndas way Wesldlunandeaii

analnldnlsaniu .webm

= 3 v A& v v £ v @ ° v
‘53‘1.|‘1.|ﬁ]33~lﬂﬁLﬂU‘1J%V|ﬂ‘lWﬁs‘l’J 'vnn@mmi@yawmﬂmm‘mwﬂm
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nmwsheaeths RecordRTC

16-9-2563-dhpt8.webm 208MB 192041080  00:11 (4]
This file is in your browser cache. Click hete to download.
T S ¥ @ i 5 [ @ et 7 [ | o[ e [ R o [ R 8]« e« R W= 8]
SA® soemc00Ss QNS

msJata:

&em workshop
for clinical teachers ™ erumsemine

Figneioo fvonso

Tumaumadiass RecordRTC #1

wisulsd www.google.com laefinsiendimaa chrome extension

chrome.google.com » webstore
Google: Chrome Web store extensions

Discover great apps, games, extensions and themes for Google Chrome

chrome.google.com » webstore v

Chrome Web Store

Chrome Web Store. Customize and Personalize Chrome on your deskiop computer with
Extensions, Themes and Apps. Power up your Chrome. You can add

AUEANUITUIAAAIUMSANKINGIMERSAVIW (FIFD) ATUEIWNYAARSASS1BWE1Ua Tel. 02-4199978, 02-4196637
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Fugaumafass RecordRTC #2

wahgiiuled Chrome Web Store ush lidwnen RecordRTC aglenadntesnm

Extensions

RecordRTC
T T
Rrecons screen actly, camera, mic, tab, speakers in 4K HD video format (using RecoriTC:

wEEn e 40 Frodun

WebBoard RecordRTC
ffered by Codelabs Studa

ra, 148, Speakers in 4K HD video format cn web-whisboard io

FRecanRTC is used in record entine scroen or record any appication scroen of audiosta Lc
EARER Pt

duaaumitings RecordRTC #3

Thunadiluii RecordRTC uay natlu Add to chrome itavimséinsioun Browser google chrome

RecordRTC
Offered by: Mtp/vwww. webrtc-erperiment.com

Fk k& 60 | Productivity | 2 10,000+ users

& Drama.webm (Size: 4.53 MB) [T ——y
Al s I chch. G o b 1 ot . e © some s e
— e —— = |
I [0 e
© o
from Dramas to US8 Drive (D7) © 1o s o
< te
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dumaumianes RecordRTC #3

Tihunailui RecordRTC uas natlu Add to chrome siavinséasiou Browser google chrome

RecordRTC
Offered by: Mtps/wwm.webrtc-esperiment.

dekkok & 60 | Product

- *%0 1
& Drama.webm (Size: 4.53 MB) [
o b o G < et

@t sown+ oere
[a—"go-u—-w
© orre
from Dramas to US8 Drive (D) © s o
te n |Q ooy

L

Tugaumsdinss RecordRTC #4

WafindaaSauarasddyanuaidanmn
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Asnmdnu RecordRTC #1 5

‘ Ak w @ a % HE s 00 N
dulsznauiiengis - ; ==
0 Screen Only (without audio)

ilarou R fumsidansasdomaisfinmhaatsivanesuiwy @Y Screen + Microphone
0 Screen + Speakers

Ussnvmatiudin & 11 suoy 5
N 0 Screen + Microphone + Speakers

Option uamsuesen 7 ) Chrome Tab

. 4. . Gy Chrome Tab (Audio Only)

See All Recordlng NALaFRIMIQUsLIMILUNN
N 0 Full Screen + Camera

e Microphone + Camera

@ Microphone + Speakers

e Microphone Only

0 Speakers Only

Options | See All Recordings

Anmnu RecordRTC #2

Screen Only(without audio) : Uhufinheauiii

Screen + Microphone : tufinmhaensasilalestis

Screen + Speakers : hufinmhaansasFesslig

Screen + Microphone + Speakers : thufinmhaansonlaleslruazdusaning

Chrome Tab : thiinan Chrome Tab snsnseniusin VDO uay Fele!
Chrome Tab (Audio Only) : ufinan Chrome Tab uwsdamaieaies

Full Screen + Camera : Whfiniambiee uaz ndag

Microphone + Speakers : Thufinamzdesanllesti uay Hosanalng
Microphone Only : tufnssnzumnlalaslbarini

Speakers Only : TiiniFesannanlwarini
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UW.BrUINNS SaUNDSLISOL

HoUo : Demonstrate and Workshop:
Infographic makers for creating an infographic: Piktochart

Media creation tools
Infographic design

Chayapat Rattanakitrungruang, M.D.
SHEE

Information

+

INFO GRAPHIC ==l

Graphic

CORPORATE
SYNERGIES®
corpsyn.com

The F.A.S.T. Method
to Identify a Stroke

Data communication
using visual graphic

oke symptoms may include:

+ Numbness on one side of the body
dache
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[ASuN1soUSUIBIUNUR 1509 Media creation tools for online courses 29 - 30 Mar 2021

Design component

Coughing High Fever

Pneumonio Shortness of breath

Vomiting o Diorrheo

IN SOME CASES
IN SOME CASES

Comparison

Avoid shoking hands
ond hugging
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Design component

e Timeline

Coronavirus Timeline: The Beginning

@  p 5

China alerts WHO Identification of new First case outside Death toll climbs to
about several virus COVID-19 China reported in 132, 6000 new
pneumonia cases Thailand cases reported
2019 ; I ] - I 92 I 2020
Dec31 Jan7 Jan13 Jan 29
First patient develops Wuhan'’s wholesale Firstdeathin Wuhan placed under
symptoms of Wuhan seafood market shut China recorded quarantine, rail and air
coronavirus down services suspended

Diagnosing Diabetic Ketoacidosis

(DKA) in Children*

Attractive
Memorable
Easy access
Understandable
Social sharing

Ketones

>3 mmol /L

PpH of 7.1 or above = Mild or Moderate DKA
pHof 7.1 or less = Severe DKA
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0 Focus on a single topic

Asystole / PEA
Tachycardia

ACLS Bradycardia
Shockable rhythm
ROSC

Effective infographic

a Keep it simple

THE 7 STYLES OF LEARNING

__ SOLTARY (INTRAPERSONAL

T

Effective infographic
e Use short text

Ny i

AUgAUITUIAAAUNMSANKINEIAMARSIVAIW (FIFID) ALUIWNGAIANSASS1BWEIUNa Tel. 02-4199978, 02-4196637



[ASIMSaUSUIBIUAURA 1500 Media creation tools for online courses 29 - 30 Mar 2021

Effective infographic
° Good design is effective

Pr oximity Layout &
White space Composition
Alignment .
Contrast

Repetition

B« Watch VDO

Effective infographic
e Choose attractive color

Color
Theory

Beginning Graphic Design: Color

538,990 views - Oct §, 2016 il 16 Bl TT4 A SHARE S SAVE ...

In this video, you'l leam the biasics of using calor in graphic design. Vis

[ ] Watch VDO
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Color wheel

Warm or Cold

Blue

Warm colors

Cold colors

Color wheel

Red

Purple Orange

Analogous
color

Yellow

Green

Warm colors

00006 )

Cold colors

200000
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Monochromatic color J

Complementary

J Green
Warm colors

Cold colors

! !
90000
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Color wheel

Red

Purple

Triadic color

Blue

Green

Warm colors

Cold colors

Orange

Yellow

Recommend

P Ml o) 00077036

14 Infographic Do's and Don'ts to Design Beautiful and Effective Infographics

Watch VDO
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What would you like to create today?

E.HH.I

Infographics s Reports. Flyers Custom Sizes

Long form graphics ars Insightful reports for Visual in any size

perfect for web peint you need
AdfLeter

Content

* Introduction to Piktochart
* Work type & instruments

* Work flow
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Introduction to piktochart

5’ PIKTOCHART

*

Web-based program (PC only)

* Creating all visual medias except VDO

%

Export files to your personal PC

* Free account with limited access

AUEAUITUIAAAUNISANNTNGNFERSIVAW (FAAI) ATUIWNYAERSASS1BWEIU1A Tel. 02-4199978, 02-4196637 “
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Free account

Visuals 5 visuals

Limited

Other function
(Pro only)

With watermark

Level of user account

Pro account (29 $/month)
Unlimited visuals

PNG PDF PPT

More theme pictures

Removed watermark

Password-protect your work
Custom color schemes
Custom font upload
Working as a team (Free-trial 14 days)

fwww.piktochart.com

E)PIKTOCHART FORMATS SOLUTIONS FOR TEAMS PRICING

Your all-in-one
visual communication
solution

Easily create reports, pr ions, infographics, secial media graphics,

and prints. You can turn any text-heavy content into a visual story that
sticks with Piktochart’s collaborative design platform.

START FOR FREE

AUgAUITUIAAAUNMSANWINGIMARSIVATW (FIFID) ALUIWNGAIANSASS1BWEIUNa Tel. 02-4199978, 02-4196637
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www.piktochart.com

&’ PIKTOCHART

Sign in with

Google ¥ Facebook

or with email

Email

Password

Forgot your password?

MNew here? Create an account.

Forgot your email?

PIKTOCHART

Your Saved Visuals 75 v crea g o |

Create New

Personal visuals

Basic onlinge

Demonstration 1
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Work type & instruments

WO r k Create New

* Infographics

* Presentation

NNBLAA
nnusznnen 19 function
ANSNINIUUUULABINY
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ISNAUNNT L9 UN “Create New”

B Dashboard | Piktochart X |+

< C & create.piktochart.com/infographic B B0 O N a :

PIKTOCHART o Chayapat Ratt

Infographics | Easily create long-form graphics perfect for the web

(g ) -
teps for
& PRIVACY POLICY = Safeguarding |4
Onsite
. . Envployess
Start from blank o
&
o
N
\-\-- P ......
~
It's a blank template Ways To Look After Your M, Privacy Policy Tips To Rebuild Your Small B, New Normal On-site Safety

LADNUSLLANYBIFDNADINITHIY

What would you like to create today?

-

Custom Sizes
Visual in any size
you need
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Llaan Theme 284 Infographic

Infographics | Easily create long-form graphics perfect for the web Theme ’jnN
o <
Q Search infographic templates Theme a’] Li%zﬂ
Search theme

: (- (FEuRes)

Ways To Look After Tips To Rebulld Steps for

Your Small Business Safeguarding
& PRIVACY POLICY @
Q; - - . Employees
A et
Start from blank Pl
custom size

It's a blank template Ways To Look After Your M. Privacy Policy Tips To Rebuild Your Small B... Mew Normal On-site Safety

HUIHNNITN Y

@ F + 4 Shar

Export file

ALABNNTT 129U

v

NUNNITN19Y

Need help?
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(74 ] o
HTUTIOIWNATININIU

Block setting N

Canvas

Block 2

ANSUSUARIATDA N

Block setting

Visual Size

> A8y Setting awnsatdan
AUNAUALNITINUNILALDY

D Ad (210 «297 mm) v

(] Portrait (] Landscape

Width Height

> d1N130U5UDRIaIU TASIas9
i e luliignnuauie Tranis
Avua laaas

297 = | 210 mm ~
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AN5USUIUIATDATN

Visual Size email@email.com
#1304 104201
| D ABS (148 x 210 mrr

[ Portrait (] Landscape

sl B8

Resize content

148 = | 210 mm ~ 2
_— > Tusunsnazdsudnaiuzaaiian

[ ) Resize Content g lulvdulauanumnnzas

ALAUIANINALIIABINSIU AU AY

= 63%

|

1. Preview gaiuauuuy
2. Download W& PNG

3. Share unslvigaugeiu
Link
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<3

Save © Praview

Graphic: Shape & Icons o

el
dnsunisiann laguisanade
uaz lomaus ey

= Shapes & lcons

Shapes - Basic

All

(@w19915 %32 AunIsN lanila
Search icon here)

AASULADNNTN lDADY

a09 (Lidsu lviidan)
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Shap

lllustrations

Graphic: Line

Lines

a519tduasy 4 lvitdaan 3 wuu
loun iduiny wuise 1dugn

File ~ # My Visual
» Photos

e - |

&

m “ﬁi‘,{ @ensUusznaudInsuns o
e

U §INTAAUNISH LA
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8 By £ Av =~ M I

Graphic: Photo frame

\@annsaugy wa ldnusuaw
daua2 luiny Upload
a

Function
Design components

1don TAsea319 Infographic
susagundasnsin sy ly
Ansrne 3 Uszian laun

Timelines

1. Lists
2. Timeline
3. Comparisons

Comparisens
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joad PN NEIUATU TUSHNTNLND

JPG, PNG, GIF, or SVG

Browse Images ‘12?’\3’]“ Iﬂﬂ Free account Q‘?J
lawun 40 MB

(\Watanua Anenins Clear

1
=

wuniiuszes)

Function

[EI Background Colors

Background Image BaCkgrOund

\daniunassnsuaanIn
swnsadaniily &y
(Color) %58 AMNAUKAI
(Background image)

Background Flo ynags

Tunsainass blockymnn'h
1 block ASLUABUNUKAY 9
wWun1silasuenie block

&

W
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Function

Title -

Subtitle

Subtitle 2

Subtitle 3

l@anUsSLANB AN

Body Text

#130N52UYBAMNNABDINS
(USuoiia font lunun setting)

[El Text Frame

v T. 20 v B ] U

il
<
1
|3
<
S
(o
<
n
£

LATDINDNLAREINIUNITATINY
§lviaean 3 Uszan laun

Charts
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Task#0

*

THizaunnvinu wing lisunsa piktochart s
www.piktochart.com

*

aalwansrinen s Tag Ui Tuuezas Infographic

=l

taan Blank template

*

* HnUfuia function enee) luwsawnnuinansnan

Task#1

Ana: Wiinuashelidnsrinauguuuy Infographic

Tazivua 1

- 5uauann Tasesnawan (Blank template)

- #3579 Canvas lvidsznauluaas 2 block

- upaz block NMWUA size INNU2UIA A4 UHIUDY

- gfunisanuas 1w Block 1 !
> ¥idan Desigh component AitrnzaniuauIaxn 1 Design
> ‘[#idan Graphic #dia illustration uaz photo 1 ldaginsas 1 51
> 196 Text 1lu title 1 2aan
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Task#1

ANEa: Tvivinuashelwanisvinaugduuy Infographic laaivua 1v
- gfiunsanuelu Block 2 a4l

> ‘l¥ldan Background la

> sl:ﬁ' Upload sua w1 sUn 1w waztaan Photo frame

Awinnzanann graphic a1y

> 1@an Text frame 1 sfiald

> wuy VDO YouTube 1 Link
- @518 1% Download 1flu PNG ssde lWaiiudinasenissang s
124 Chayapat1 [@anaanw normal uaziiufinuuulaiuan Block
(1¥52u 2 block flugiidaanii)
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LA BNUNAN/UTZLANANNINABINITNNED

: \d@ansUuuude ,
Infographic / Presentation / Poster

Work flow asUdssiiu waz InaeL lAseasegaya

14 1A59519911 (Draft)

WV

&51997% 1 Piktochart

Example

Tons

MuaasnIsuntaualsuiua1Atan Active learning
aanun lusiuuu2as Infographic

TUAuvanas waztsauseeIn

a2 Tating
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11B¥1204 Active learning

* ANNNNYYDN Active learning

* sduuunIsaanany Active learning
* nann1saau (FAIR)

* ANNNUABNNISEY (VARK)

Walavdauan TrluasUuszaudran

niaanuLauauu Infographic

219 1A59919

Topic FAIR
Design component Lists
Theme color Warm
Size 1 Slide
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FAIR

Feedback Activities
Content Content
Individualization Relevance
Contenét Content

iR lyaselu Piktochart ...

Reference / More details / Link

Task#2

o & Y % o ’
Aaa: Tavinuaselwdnisvineusiuuy Presentation

LY

°lvig|,mausuﬁnu,m Slide (aiiaun1siasauaau / ml,aum'm
°luﬁ"3ﬁ'ﬂnmuumummmmﬂﬂ Tasvin 2 slide aadl

w1 wihdn Usznaueie devade %awaau

-2 wmuammﬂa?‘iaﬂ %38 content finzussee

- wesaud IWsadalna dudiaasenuseng w2 wiu Chayapat2

- ia991n1U 1% Copy link waeu wwsas lu group line
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Task#3

Aaa: TrnuasrelndnisvinausUuuy Infographic

Tng liuaasuaufionssun1sausuaas Media creation tools
Fudi 29-30 fiunan 2564 2una Ad wuas Tagiissazdeaasi
- IfiSauanseguuuy Infographic figaenisasha

- 83190 17 Desigh component ilszian Timelines at5931)
winpanuwuy ndaanla

- fiariaSauas Wusuaunadadiu A5 Taa 'l resize content

86 luNf
Fuil 29 fiurau 2564 Fuil 30 fiunau 2564
9.00 - 10.15 Tips for designing visual media 9.00 - 12.00 Canva
10.30 - 12.00 Screen recording tools 13.00 - 16.00 Powtoon
13.00 - 16.00 Piktochart

Task#3

- i@5aua lvieszn Inaidutiaaseinimainge3 iy Chayapat3
- #ia991nil 19 Copy link maau uzrsas 1y group line

Fuit 29 fiunmu 2564 3l 30 fiunau 2564
9.00 - 10.15 Tips for designing visual media 9.00 - 12.00 Canva
10.30 - 12.00 Screen recording tools 13.00 - 16.00 Powtoon
13.00 - 16.00 Piktochart
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§ < Piktochorf

TELLVISUALSTORIES

Reports Presentations

Infographics

Thank you

PRECLINICAL

TEACHING METHODS
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loNd1sus:NouUN1ISouUSU

E ”.._ B

30 March 2021
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Media creation tools

Chinnaphat Chaiwattanateerakorn, M.D.
SHEE

@ & o
Design l :
gwith & Working

©CCAWA < a team
o

@
Getting anywhere

start D DQ

Publish
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- Sign up

Navigate homepage

Getting - Create a design
start

Navigate Canva editor

@ Collsborate & Create Amazing X

+

€ 3 C & cawacom WWW.CANVA.COM

< Log in to your account

G Log in with Google
0 Log in with Facebook

‘ Login with Apple

Email/Cell l Log in With

chinnaphat.cha@mahidol.edu YO u r ema| I aCCO u nt

Password

Login

Fargot password?

/7

name.sur@mabhidol.edu

New to Canva? Signun
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- HOMEPAGE

9 Navigation bar

@ Home Templates v  Features~  Learnw

0o o IR @

(R) Recommended for you
08 Al your designs
181 Shared with you

9 Classwork

)
Brand Kit
Recommended Social Media Events Marketing Documents Prints
B3 Allyour folders
W Trash h ™ L &

D Aseial

¥ J.M«sf:f_rmﬂ g”Q W
& ‘a \ }

°i Side panel W o Designs section

.
"

St chinnaphat's team

HOMEPAGE

@ Home Templates~  Features~  Learnw

#*

Qs

Business Card

(A Recommended for you

(3
*Ielcome, chi

Video

"Magic lies in challenging what seems impossible.” —Carol Moseley Braun »

[

School Personal Custom Size

Instagram Story Poster

\ 4

0o o RN @

:@ Infographic

n Size

08 Al your designs
Video
0 shared with you .
. Choose presentation [EREE
6 Classwork 3 Facebook Cover
Brand Kit [@ Book Cover
Recommended Social Media Events Marketing Documents F
B3 Al your folders [d Phone wallpaper
[ y
T Trash b i & R i
deeial \
r\\ Jt.‘au::(m ¥ W
<A chinnaphat's team .\ \\\
Video Presentation Logo Instagram Post

1080 » 1080 px

Instagram Story Poster
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- HOMEPAGE

@ Home Templates v  Features~  Learn v Q| search desig ates, and more @ {C}} J:\ e@

(il Recommended for you

¥

BB Allyour designs

(' .
*lelcome, chinnaph%

+2?, Shared with you

“Reality leaves a lot to the imagination.” — John Lennon »

& Classwork #

Brand Kit

_————
Recommended Social Media Events Marketing Documents Prints Video School Personal Custom Size

B3 Allyour folders
—
—

Ei' Trash

THEAGTIVE)
it

R chinnaphat's team e —

— Select a design Resume

from design section

SIDE PANEL Templates

T
Folders e new U ploads

B

Photos & Elements
Text

Music & Videos
Background

Folders

AUEANUITUIAAAIUMSANKINGIMERSAVNW (FIFD) ATUEIWNYAARSASS1BWEUA Tel. 02-4199978, 02-4196637



[ASIN1SoUSUIBIUAURA 1$09 Media creation tools for online courses 29 - 30 Mar 2021

- Edit text

- Add photo or illustrations

- Add, delete, duplicate page
- Add QR code

- Choose and edit template

- Create your design

- Rename

Assignment

0 1 “ Assignment01_XXX”
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L N 1 - Save

9 - Share and download

Publish - Present and record
anywhere

- Team and class
- Navigate teampage
- Add members

- Classwork
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Create teams to easily share m
and on each other’s designs

R 2 o

In CANVA for Education
Team I Class

Owner — Teacher

Member 4 Student
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[ASUN1SOUSUIBIUNU

Canva need to 1 existing team to run the account

1. Create XXX team as your private working area
2. Create SHEE_01 team to work as a team

- TEAMPAGE XXX

@ Home  Templates ~ Features Learn ~ Pricing ~

(A) Recommen ded for you

EB All your designs

Account settings

vog! Shared with you

@ Brand Kit
B3 Allyour folders
IE[ Trash
By xxx
+  Invite members Designs Folders Apps People Groups
« Try Canva Pro ' n
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- TEAMPAGE XXX

@ Home Templates Features Learn ~ Pricing ~

Chinnaphat Chaiwattanate,., /s sou e
chainchinnaphai@gmallcom  guuee ggeec

® Your account Enter your company address

0 1 Billing contacts

All billing-related emails will be sent to your email address and these billing
E3 Billing & Teams contacts

l [nter an emall address |

+ Add new billing contact

Team
cameanouren Create a new team

GB Print orders

- TEAMPAGE SHEE_01

Home Templates Features - Learn Pricing ~
@ ’ Ml Change team name

@ Recommended for you “SH EE_O1 ”

08 Al your designs

+g§ Shared with you

SHEE_01

o} rral

Bz sHEE.01

+  Invite members Designs Folders Apps Peaple Groups

B
* Try Canva Pro I
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5w Lea

- TEAMPAGE SHEE 01
@ e 0o o CHEE @

Folders Apps Peaple Groups

(A} Recommended far you
BB Alyour designs Invite class members for free
o0 shared with you ' §

It is your responsibility to get par Iplmssan

6 Casswark under the age of 13 to use Canva for Education, in 0 In\”te by ||nk
ith the Children's Online Privacy Protection Act (if ppl Ie]

Brand Kit 5

and our Privacy Policy.

[ Al your folders
L] Get invite link

@ o (2 ] Invite by email

o : 3
: Type your team email ' T
4 i

XXX.xx@mahidol.edu

Add members as owner by
email in “SHEE_01” team

- Each member create a poster
in SHEE_01 team

Assignment
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Teacher can easily
M, :1 0l provide feedback

on each student’s designs

Mr. Partner Tester

@ Home Templates~  Featuresw  Learn v @ @ 1:1 Create a design e$

(R Recommended for you Media creation tOOIS [l

08 Allyour designs
Create a design

(@ Recent designs

_gl Shared with you

9 Classwork

&) Brand Kit

Designs Folders Apps People Groups

B2 Allyour folders

T Trash Clossreom Rules

<t Media creation tools I, g Teacher;S teampage

Classroom Rules
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¢ Home  File  View  Resize €3 A/ hanses s

O Animate

@ Home Templates~  Features~  Learn w

|j'-:] Recommended for you
O8 il your designs

@ Recent designs

.81 Shared with you

& Classwork

Brand Kit

B3 Al your folders

E Trash

=t Media creation tools

Designs Folders

Share Clas: Share sl Download n

Share designs with others to view and edit

oo @
Choose team/classroom

|. De your best

2. Be ready te learn

3. Eyes forward and listen
Y. Raise your hand

S. Be respectful

b. Say please and thank yeu
7. Keep hands to yourself
8. Follow directions

9. Try new things

10. Werk hard and have fun
11. Believe in yourself

+Add page

& Canedit '
Media creation tools & Canview

chinnaphat.edu @5 Not shared

chinnaphat.cha@mahidel. edu

Choose what

members/students can do

Student’s teampage ® & A [y

Media creation tools

Groups

ﬂu!gnmentx

AssignmentX

%m Rules

Classroom Rules
e

Design and assignment

y A

Mr. Partner Tester
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AssignmentX

o s chinnaphat.edu

AssignmentX

AdniSou

- @5 design tusUuuu
presentation $1usu 1 page

- ldsUnwivausudu 1 sUAw

@ Home Templates~  Features~  Learn s @ @ 0 Q@

Q pesre

STArT witn an image
(A) Recommended for you =

Suggested

B0 Al n
your designs ] video Presentation

(© Recent designs DO hiS Classwork e /n | O Infographic
fd poster

m Resume

oS8 Shared with you

B classwork
G Presentation 1920 -

@ Logo

Brand Kit

@
B3 Al your folders
jaj

Trash

Designs Folders People Groups

9

Media creation tools
CED enex TR Rules

MRadmiou
atw design gy
presentation S 1 page

' Mr. Partner Tester
AssignmentX Classroom Rules
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@ Send to teacher

¢ Home File View Resize © How Cli

Send to teacher

© Animate (~) send to teacher %

Teacher

Choose teacher’s email 0 .

chinnaphat cha@mahidol edu

Message

#3237 assignmentX
SUMUTIERTINMEIBATY

46/1500

+ Add page

Mr. Partner Tester o 0 2

< Home File View Resize = How Cloth Face Coverngs Help Slow the Spread Share i @ Awaiting feedback

Q© Animate

+ Add page

Mr. Partner Tester % e
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@ e e o e © @ a e

(A Recommended for you c‘asswork
; Status
ea All your designs

All approvals ~

© Rrec igns

Title From Status Updated
*82 Sh you

—
&) Classwork z How Cloth Face Caverngs Help Slow the Spread ° Partner Tester [hees review J Just now

Click

T Trash

< Media creation toals

Mr. Partner Tester

@ Home Templates~  Features~  Learn v (@R AN Create a design e@

(A Recommended for you classwork
Eﬁ All your designs StatUS
All approvals v

(© Recent designs

Title From Status Updated
+82 Shared with you

-
& Classwork How Clath Face Coverngs Help Slow the Spread ° Partner Tester Just now

@ Brand Kit

B3 Allyour folders

ﬂ[ Trash

<A1 Media creation tools

Mr. Partner Tester
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@ T ST ® & 2 [

(A) Recommended for you CIasvaork Status
Eﬁ All your designs -

Title From Requested

(© Recent designs

/1019
R shared with you ﬂ How Cloth Face Coverngs Help Slow the Spread e Partner Tester Just now

£ Classwork

) Brand Kit

B3 Al your folders Click to review

'@ Trash

1 Media creation tools

How Cloth Face
Coverngs Help Slow the
Spread

e £y Partner Tester

Message

daau assignmentX FUNTUBNTTIRTINN
dwaiy

Review

Click to review

AUEANUITUIAAAIUMSANKINGIMERSAVIW (FIFD) ATUEIWNYAARSASS1BWE1Ua Tel. 02-4199978, 02-4196637 “



[ASIN1SoUSUIBIUAURA 1$09 Media creation tools for online courses 29 - 30 Mar 2021

¢ Home File View Resize All cha af How Cloth Face Coverngs Help Slow the Spread 4 P n
© Animate Click to review © review

Feedback message

0/1500

Give feedback

Return

Return to student

< Home File View Al changes save How Cloth Face Coverngs Help Slow the Spread Share A Download u

+/ Design approved.

ot Human Ecanomics
gn Dapartment
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@ Home Templates~  Features~  Learnw @ @ Q. Create a design e@

(R) Recommended for you classwork

08 Allyour designs

® Recent designs

+8 shared with you

& Classwork Status

Brand Kit

3 All your folders

W Trash

St Media creation tools All caught up!

- Join "media creation tools”

by link

Assignment

- Do a classwork individually

- Send your classwork
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Questions & Comments
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W@A.QS.2SISSTU UBLUIDSUBY

HoUo : Demonstrate and Workshop:
Animation tool for making videos and presentations: Powtoon

13l 9w lUsunIN Powtoon

lag
HA.T.2927706 AT L9 T Y T8

% powToonN
Powtoon Features

) =3 a L dl Y o L d v ad o d’ v v
* PowToon tJutTuna dwatasu b gd1nsun13a3193a ladaua N uni1szsislu
gﬂl,mum{@]ua gr9aunIadulnnaWnuuuiadanlng

* faamiqu lanau jUunmwaulwniinuaz Template di5a3ulwiAanldau
* 3101700 U A ANA A YouTube, Publish 1w W PDF uaz PPT
® 814130 capture recording screen, add-in PowerPoint

o o & a Ao o v A A aa 2
* #1nsULaTTUNIV PowToon 49a311a Ao Ha9TwWIaddla 1 7w ANE17
laiiu 3 wfiuazdasdaarsiinuas PowToon 32419 Storage #1%TUN1TIALAL
v 3
ldgegauaniairiaz 100 MB
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% Pawtoon Workspace X | & stwdio| Powioon X % Powtoon Workspace x 4+

€ C @ powtoon.com/new-dashboard/#/home?toclbarState=defaulttoolbarWidget=myPowtaonséshowPricing=true

STUDENT TEACHER

$ B
$ 4 /mo S 6 /mo

$48/Billed Yearly $72 / Billed Yearly

* Access to Pro & free content
* 2GB storage
* HD video (720p)
and more. * 10 CE storage
= Full HD video (1080p)

access to all content

and more.

‘ GET PLAN

GET PLAN

CLASSROOM

- ©
o

_©/

s10 /mo

$120/ Billed Yearly

* 60 Classroo

» Unlimited access to all content
+10 GB Storage

= Full HD video (1080p)

and mare.

% Powtcon Workspace X | & Stwdio| Powioon X & Poutoon Workspace X 4+

€ C @ powtoon.com/new-dashboard/#/home?toclbarState=defaultatoolbarWidget=myPowtaonséishowPricing=true

FEATURES

Screen & webcam recording

Storage

Powtoon branding removed

Classroom Students

Privacy Control

24/7 Priority Support

Royalty-Free Music

Let's Compare

Free Student
100 recordings 200 recordings

100 MB 2GB

EDU Branding

Free soundtracks only Pro-Level Access

Teacher

200 recordings

10GB

EDU Branding

10 Classroom students*

Unlimited Access
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& Powtoon Workspace x | & studio] Powtoon X & Powtoon Workspace x o+ = X

< C @ powtooncom/new-dashboard/#/home?toolbarState=default8itoolbarWidget=myPowtoons&showPricing=true wax @

ASSETS
Royalty-Free Music Free soundtracks only Pro-Level Access Unlimited Access

Royalty-Free Objects Free objects only Pro-Level Access Unlimited Access

EXPORT

Max Length Up to 3 mins (HD) Up to 10 mins (HD) Up to 20 mins (Full HD)

Download as MP4 v v

Student Teacher

GET PLAN GET PLAN

* More students can be added after purchase

& Video Maker | Make Videosand = X+ = x

&« > C @ powtooncom

Q
#7

%pow'roon DISCOVER TEMPLATES SOLUTIONS PRICING SIGN UP

http://www.powtoon.com

Create unique \RanLuLy Login
videos|

& PowTooN

Powtoon is the visual communication platform that VISUAL
COMMUNICATION /
fully customized videos your audience will love. PLATFORM

Sign up for a free trial today. /

gives you the freedom to create professional and
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% Login| Powtoon x + — X

<« C & powtoon.com/account/login/ wax @

TN
%POWTOO“ | The Visual Communication Platform

Login to Powtoon

New to Powtoon? Create an account
Email / Username

Password

Remember me Forgot your password?

@ Facebook 1] Office 365

A . (%
Login to your Enterprise account La a ﬂ LOg | n @l ’) ﬂ GOOg I e

& Getting Started | Powtoon X  + =

=]
X

< C' @& powtoon.com/new-dashboard/#/interim-onboarding/job-title ® aQ ¥ = ‘g :

% 2owtoon

Corporate Executive Manager Team Member

g = &8

>
® &
aandawldnieuin
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S5 Getting Started | Powtoon x o+

< c

& powtoon.com/new-dashboard/#/interim-onboarding/job-title

% 2owtoon

Team Member

oQo

aD

Individual

&

B a v @

lam a...

Educational Institution

iu{ <

Student

Teacher

O

AanLaan Teacher

(U Getting Started | Powtoon X+

<« X @ powtoon.com/account/gdpr-consent/Znext=/my-powtoons/?

% mowToon

WELCOME TO POWTOON!

We send all kinds of awesome tips & tricks, announcements, and exclusive deals,

but you'll only hear from us if you really want to. Can we count you in?

@ Yes! Countmein:) () No thanks. Ignorance is bliss.

aan Continue

Regardless, you will still receive service-related messages, such as export confirmations and invoices.

Waiting for js.hs-banner.com...

an
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% Powtoon Workspace X 4+ = o X

<« C @ powtoon.com/new-dashboard/#/home?toolbar Widget= on: B a % »@

A FREE gift for the next 4 days

Free access to ALL of our Pro and Pro+ content!

« Best gift ever. Unlimited videos, images,
audio, and templates FREE for the next 4 days.

« Publish anywhere. YouTube, Facebook, LinkedIn,
Twitter, Instagram... and more!

» Free for life. Even after 4 days, keep using
Powtoon with our free content.

39u5n 914 Feature 699 I W3 4 7%

Claim your gift

% Powtoon Workspace X 4+ = o X
<« C @ powtoon.com/new-dashboard/#/home?toolbar Widget= on: B a % »@
& Hi Vorawan! Toolbox
. . #1 Customi: My Powtoons
What video would you like to create today? @
() HoMe
o
TEMPLATES Z CAPTE‘ET: S
’ -
e 048 MY Powtoon
CREATE ; n 2 ‘ ‘ ‘
W 2 =
Teachers & Faculty
Learning Center
2 i
Help More Tour

Apps & Integrations @

W PRICING

Administrative Staff Training
Vorawan

v
& vanicharoenchai

Featured Templates

Powered by

% sowTtoon

New §8 Premium templates Most Popular  Virtual Events

12
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% Powtoon Workspace X 4 = X
< C @ powtoon.com/new-dashboard/#/blank?toolbarState=default&toolbarWidget=myPowtoons B Q & *» @ :
% = Create a new video Tatal 515 -
. My Powtoons
Design. Create. Share. ©
HOME
TEMPLATES
IMPORT
(D creaTE % 16:9
® >
Capture Horizontal Square
Learning Center
[ =
Help More Tour A
Lﬂ i’] ﬂ DeSIg n Apps & Integrations @
@ e N A o
( W PRICING )
T JIBNABINIT
Vorawan .
& vanicharoenchai
e e
8 Giftexpiresin: o o
03:23: 5] % 2owToon
DAYS HOURS MINS

13

& Powtoon Workspace X & studio | Powtoon x 4+ = X

C @ powtoon.com/htmi5-studio/#/edit/cp7uatiZLiR e v »@ :

Hi Vorawan, let's choose a look for your Powtoon

CARTOON

\Ran3duuy (look) N IN1T&IN9

DR

L [P

And many more.

1A
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& studio | Powtoon x 4+ = X

<« C @ powtoon.com/html5-studio/#/edit/dgBbC2EusOo & Q W 0O ® © 00 < I U T

=® sowToon EoIm @ L s 2 Untitled

Slide 1 of 1

L% INFOGRAPHICLOOK W
@) aria B3 Horizontal 16:9) ¥ - —@— + 100% "o
o1

=2 { earc aracters H:]
. ARNLUA YU look . oy

Add characters

T

Blank slide ©

MY CHARACTERS

v

00

) [>] ’ 00:05:00 | 00:56 7Y v

INFOGRAPHIC CHARACTERS - FREE

, . - S
Premium trial ends - S @’ a/ e
R S AN el >

ETCH-IT-ALL

s
%ggw%sgeon RHAPSODY @
=
dd

7/

@ UPGRADE

15

% studio | Powtoon X o+ = [ul X
« C @ powtoon.com/html5-studio/#/edit/dgBbC2EusOo ® a % 0 ® %00 W@ :
0 00 D CREATE ©) A 2 ed AVED PR AR EXPORT v
Slide 1 ofl 2% INFOGRAPHIC LOOK
® )Grid B3 Horizontal (16:9) ¥ - —@— + 100% 82 e
o1

Search Characters Q Ej
2 swar £}

Add characters e
T

Blank slide @

0 MY CHARACTERS

Ad a a &
ﬂsmﬂLW\‘]a\jﬂ:LUﬂulﬂﬂiuﬂiuﬂidujﬂ 32UV > ? |

L1

alﬁmﬁﬂi‘m"ﬁ' Premium, Scenes, Characters, LL8< .)‘ fuad

o

CREATED USING RHAPSODY

-
s
Objects 19RNANT 4 7% nadanwuazlldiamy  Srowrcon @
&=
Ir

Alss i OO O

00:05:00 | 00:56 N (B v

l CRar INFOGRAPHIC CHARACTERS - FREE

5 1 > 3 a 6s 8s 9 1 +; £ + E\
Premium trial ends v - @' E/ g e
03:23: 41 = &

ETCH-IT-ALL

1A
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Premium trial ends

93:23: 18

& Sstudio | Powtoon X 4+ o = X
« C @ powtoon.com/htmi5-studio/#/edit/dgBbC2EusO0 N1 SEI,GE LN W Scen es ® Q % 0O® %00 W o n@ :
U
=® sowtoon £ @ SAVED  PREVIEW  SHARE
Slide 1 of 1 ) INFOGRAPHIC LOOK v
@) Grid B3 Horizontal 16:9) W - —@— + 100%
o1
Search Scenes Q
2swar £}
a A 0 & tié Save current scene
aaniiald Scene luglag =
Choose a scene T
Blank slide
E:] R
g =
< MY SCENES
AC
)
S oSN Y B
v
INTROS ]
) [ >] ’ 00:05:00 | 00:56 . f J?
3 S
M| ©

@ UuPGRADE

SPECIFICS

Premium trial ends

93:23: 16

© UPGRADE

& studio | Powtoon X 4+ o = X
€ ¢ (& powtoon convitmibsidioftedi/dgRbe2Eastn N1 jal,?j LN W Scen es ® a % 0 ® %00 e @
u
=® sowtoon Eo @ SAVE  PREVIEW SHARE
Slide 1 of1 L1 INFOGRAPHIC LOOK v
@ )arid B3 Horizontal 16:9) ¥ - —@— + 100%
o1
VS@O Search Scenes Q E
>
S 2 swar £}
MY SCENES
. T
Blank slide " =
> R
VS INTROS
3 | =N
< a A a o
ARNLADN Scene NABINIT e
'% 'CREATED USING @
POWTOON
el
&J
cﬂy)) [ »] ’ 00:05:00 | 00:56 Jg
o
&
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Premium trial ends
03:23: 11
NS e

© uPGRADE

) = 3 INFOGRAPHIC LOOK v

& studio | Powtoon x e o
& C @ powtooncom/htmlS-studio/#/edit/dgBbC2EusO0 N1 51‘,6 L }'Ilj B ac kg roun d ® @
=* sowToon o ©)
S @) Gria B3 Horizontal (16:9) ¥ - —@— + 100%
a A 1 6
"59‘,9 <n u AANAAlE Background lugla e —>
Blank slide
‘ =
g 93'53?53603/
cn,)) [ .] ’ 00:05:00 | 00:56

Q

&3> Upload your background

Search Background

Pick a background color

Choose a background

55)
v
MY MEDIA

e O

PREMIUM IMAGES

PREMIUM VIDEOS

2 FilliN
Swap Flip
= 00%
1 © :
Swap
Blur
din
Flip
Color  Opacity
@
. = %20 |
Color Opacity Effects AtoB '
<
g ¢ |
Arrange Link V
a
Lock

Premium trial ends

03:23: 05

@ uPGRADE

INFOGRAPHIC LOOK v

Q

Search Background

ABSTRACT BACKGROUNDS

~ |
AanLian Background ‘

=T

a9
Naainig
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= a X

& studio | Powtoon X+
<«

@
C @& powtooncom/htmis-studio/#/edit/dgBbC2EusOo ﬂ’]sl‘]jl,uu TeXt ® a % 0 ® %00 W n@
U

SAVE PREVIEW  SHARE

=® powToon eorr ®

Side 2 v of2 )
@) aria B3 Horizontal 16:0) ¥ - —@— + 100% LA

12
42% INFOGRAPHIC LOOK v

o1

\&
2 Search Text Q Ej
2swar

” AfNLAaN Text Nd0IN13 —
Add Subtitle

Add Body Text

3

Blank slide

Add designed text

<
VIDEO TITLES
& 56wroon &

VIDEO TITLES

et 2 ‘;dd for™
L)) (»] ' 00:05:00 | 00:56 ee aulet el
~ a0ty

TEXT ELEMENTS

Premium trial ends

03:23: 03

@ urGRADE

21

% studio | Powtoon x + = a X
<«

@
C @ powtoon.com/htmi-studio/#/edit/dgBbC2EusOo ﬂ’]il‘]ﬂ,uu TeXt & a % 0 ® %00 W n@
U
=® >owTtoon EDIT @ SAVE  PREVIEW SHARE

Side 2 v of2 )
@) aria B3 Horizontal 16:0) W - —@— + 100% LA

i1
44% INFOGRAPHIC LOOK v

o1

9 Open Sans \ 7 Search Text Q Ej

— < NITRUAAIGIDNTT
N ’ ©

© 0 ® .é Add Subtitle

. i Add Body Text
= Add[ritle > ot
i ‘ J .
37484F P Color | Opacity > Add designed text

®

Basic Colors

w
~
I

1]
1]
1]

o = IEREDY =5

= %o Lock Tldunlaaaanus o frrLss.
oo S & sowison , :
) 1a8an Color g &

g [»] ’ 00:05:00 | 00:56 - i r/\

Premium trial ends

93:23: 00

@ uPGRADE

AUEANUITUIAAAIUMSANKINGIMERSAVNW (FIFD) ATUEIWNYAARSASS1BWEUA Tel. 02-4199978, 02-4196637



[ASIN1SoUSUIBIUAURA 1$09 Media creation tools for online courses

29 - 30 Mar 2021

& studio | Powtoon X+ o
S C @ powtoon.com/html5-studio/#/edit/dgBbC2EusO0 N1 ilﬂj L W Text
x U
Side 2 v of2 e »0 >
B3 Horizontal (169) W —]
ot Turquoise Red Green - -
vs o “ L}
= Swap Variation
>
2 swar $F
“ ain
= Color Picker X Incert you? 3
lovelyiext Flip
Basic Colors
d Insert your %
lovely text Color Opacity
Blank slide —* Q.
‘ 3 ) A S A
lovely text
olelelelele} v Effects  AtoB
=
G g5 g8 @
My Colors Arrange Link
&
&
N 2
Lock

Premium trial ends

93:22: 52

@ upGrADE

23

Sometext | @

tobe here fext, [Texl Text, '
itten =2l

wrif ]

©

TAVAY Text

Insert Toxt _

S —
J Text Here )

INFOGRAPHIC LOOK v

% studio | Powtoon X o+ 'y
« ol ) (s e AT A R e e ﬂ’]iel,u]jl,&] % Ch aracters ® a #
U
=® cowToON orr Q)
RN 2T N @ )i B3 Horizontal (16:9) ¥ - —@— + 100%
o1
Vs
o2
2swar 3 a A o, ¢
. aaniiald Character lua'lad
Blank slide <
S aowroon
m.)) [ .] » 00:05:00 | 00:56

Premium trial ends

O3

© uprcrADE

Q

Search Characters

Add characters

©

I
)

= i v

|.|.| v

08

11

ETCH-IT-ALL

“ AUgAUITUIAAAUNMSANWINGIMARSIVATW (FIFID) ALUIWNGAIANSASS1BWEIUNa Tel. 02-4199978, 02-4196637



[ASIN1SoUSUIBIUAURA 1$09 Media creation tools for online courses 29 - 30 Mar 2021

& studio | Powtoon X+ = X

<« C @ powtoon.com/htmi5-studio/#/edit/dgBbC2EusOo

=* owToon i ®

Slide 2 v BEES

INFOGRAPHIC LOOK v

o1

—3
VS «
095 Swap Search Characters Q Ej
02 AN O
- [ > 4] T
Q=D i I. [

,,,,, .- O %

Color  Opacity

29
| o \/ @
Blank slide a -):-; °a° ‘ ‘ 3 U[F:P} h‘ h‘

Effects AtoB

=

e

g ¢ & S5Wigon % W c
Arrange Link Izl
% »

g\

a = a o
L aantaan Character 7MN&8IN13

Premium trial ends

93:22+ 40

@ upGrADE

% studio | Powtoon PR = X
&

v
e (T et oy e R P ﬂ’]jel,cﬂl,l]u PrOpS W a % O ®00  WO»@:
U
= owToon oir [©)

Side 2 v of2
= ° @) aria B3 Horizontal 16:9) ¥ - @— + 100% § (! INFOGRAPHICLOOK W
o1
\E]
og Search Props Q Ej
2 swarp Q. ,
a A GL 1 1 VL &
o2 aantiald Prop luglae el o
\ /
BASIC - FREE
Blank slide 2 ]
£8O) PRO
v v
C CREATED USING TECH & WEB OFFICE
& PowToon
— L Y
m PRO +
LR 00:05:00 | 00:56 v v
[ » CRYPTO BUSINESS

Premium trial ends ” - . 2 2 5 5 ¢ ‘ s % s '
03:20: 22 PRO
OAS | HGURS NS M

TRANSPORT MEDICAL

@ upGrADE

Ar

AUEANUITUIAAAIUMSANKINGIMERSAVNW (FIFD) ATUEIWNYAARSASS1BWEUA Tel. 02-4199978, 02-4196637



[ASIN1SoUSUIBIUAURA 1$09 Media creation tools for online courses

29 - 30 Mar 2021

& studio | Powtoon

& c

=® sowToon
Slide 2 v of2
o1
VS
o2
)

02

Blank slide

Premium trial ends
03:20: 11
A HouRs | s

@ UPGRADE

27

x

a5

@ powtoon.com/htmi5-studio/#/edit/dgBbC2EusOo

el CREATE

®

& aQa %

100%

@ ) Gria B3 Horzontal 16:9) W e ¢
a A :{ ¥ §
aanNLaan Prop naadn1g
) 00:05:00 | 00:56

1 p

_"

0 ® 00

v

%5 studio | Powtoon
«

=® >owTtoon

Slide

2 v BGES

o1

02

Blank slide

X

Sl CREATE

=

C @ powtoon.com/html5-studio/#/edit/dgBbC2EusOo

@
@ ) cria

a Horizontal (16:9) W

2swar LF

g

)

aaniineld Shape lua'lae

n13lEiay Shapes SIS

- —@— + 100%

~~

CREATED USING

POWTOON

00:05:00 | 00:56

Search Shapes

Add shapes

°

BASIC SHAPES
2 W ¢

ANIMATED SHAPES

(o]

CALLS TO ACTION

Q

QM@

v

"r"

v

v

1 p

Premium trial ends

g3l 20 807

@ UPGRADE

28

)

A/
IMAGE FRAMES

“ AUgAUITUIAAAUNMSANWINGIMARSIVATW (FIFID) ALUIWNGAIANSASS1BWEIUNa Tel. 02-4199978, 02-4196637



[ASIN1SoUSUIBIUAURA 1$09 Media creation tools for online courses 29 - 30 Mar 2021

& studio | Powtoon X 4+

v
< C (T e OB Ea0s ﬂ']j'l‘]jl,uu Shapes S YT 56 M ;
a
=® powToon o ®

11
Side 2 v of2 ) 23 INFOGRAPHICLOOK W
@ )rid B3 Horizontal (16:9) ¥ - —@— + 100% L
01
vs
o2 Search Shapes Q
=) 2 swar £}
02

L)

IMAGE FRAMES

0

Blank slide

a A A o
AANLAadN Shape NABINIT

[ »] ’ 00:05:00 | 00:56

Premium trial ends ' ' v

Q3208803

|
@ upGRADE

% Studio | Powtoon PR o = X
€ C @ powtoon.com/htmi5-studio/#/edit/dgBbC2EusOo ﬂ’]jldﬁLuu Imag eS & Q w 0 ® © 00 N *» ‘3 H
u
O 0O D CREATE ©) A PR AR EXPORT v
i1
Slide 2 ¥ of2 11
@ ) Grid B Hoicontal 16:0) W _ P o007 r'es INFOGRAPHIC LOOK v
o1
VS
pq = w Search Images Q
& swap Aid L
< a 3 (J .
o / €12 Upload image
Choose an image
r x
D o
Blank slide < v iAGES

AAN Add Image LNatdanlgnw 9
% A A A A6 o
@aIn1y wIatdanmwnldsunsudly -

v =

Premium trial ends

SE) S el Bl

Q uPGRADE

30

AUEANUITUIAAAIUMSANKINGIMERSAVNW (FIFD) ATUEIWNYAARSASS1BWEUA Tel. 02-4199978, 02-4196637



[ASIN1SoUSUIBIUAURA 1$09 Media creation tools for online courses

29 - 30 Mar 2021

INFOGRAPHIC LOOK

v

% studio | Powtoon X o+ o
€ C @ powtoon.com/html5-studio/#/edit/dgBbC2EusOo ﬂ’] ilbﬁ LaJ u VI d eOS & Q
U
=® powtoon eoir
Side 2 v of2
- ° @ ) aria B3 Horizontal (16:9) W —@— + 100%
o1
VS
o2
2 swar £F
02
a A 1 L. 1 vL &
ANNIND LR Video LR ERG =)
Blank slide a
& 56wroon
m.)) 00:05:00 | 00:56

Premium trial ends

03: 19 56

@ upcrADE

Q

Search Videos
~
€12 Upload video

Choose a video

v

Premium trial ends

03 : 19 : 51
BAE | HOURS  bNs

% Studio | Powtoon x + ) = X
- C @ powtoon.com/html5-studio/#/edit/dgBbC2EusOo ﬂ’] iicﬁLu u VldeOS & a & 0O ® © 00 e N
U
00 CREATE 0 EXPORT v
Slid r f3
- ° @) arid B3 Horizontal (16:9) W —@— + 100% [NFOGRAPRIC LOOK v
o1
VS
ﬂo— Search Videos Q
& swap #
H
Blank slide ¢
& 2dwroon
a = . A o
aantaan Video naadniy

@ uPGRADE

AUgAUITUIAAAUNMSANWINGIMARSIVATW (FIFID) ALUIWNGAIANSASS1BWEIUNa Tel. 02-4199978, 02-4196637



[ASIN1SoUSUIBIUAURA 1$09 Media creation tools for online courses

29 - 30 Mar 2021

% Studio | Powtoon X 4

< C

@& powtoon.com/htmi5-studio/#/edit/dgBbC2EusOo

ﬂ’]il“ﬁ/l,&ll‘l} sound .

=® >owTtoon

Sl CREATE @

Slide
Record a voiceover B orzontai iso) ¥ - —@— + 100%

a»

o1

ENTIRE
POWTOON

CURRENT

SLIDE ADD VOICEOVER

®© 6 O ©

Record Upload

00

02

00:00

VoiceBunny Fiverr

Start record

00:05:00 | 00:56

1p
o K = U A .
FIUNIDUWANLRY L lauLaan A

entire powtoon %38 current slide

33

aanwnala Sound lualas —»

. "

INFOGRAPHIC LOOK

v

12
i1
"y

&

Search Sound

CP Add music

Add voiceover

Choose a soundtrack

J

MY MUSIC

¢

v v
MY VOICEOVERS

PREMIUM SOUNDS

S
m

FREE SOUNDS

Studio | Powtoon

z
<

x

a

C @ powtoon.com/htmi5-studio/#/edit/dgBbC2EusO0

ms‘lem% sound

=® >owTtoon

el CREATE @

02

a a 1
Jiasa9nuny azidwn1s
A v A 6
Laaﬂl"ﬁmﬂdlunﬂav[ﬂ@]

13
Slide 2 v of2
@ ) arid B3 Horizontal (16:9) ¥ - —@— s l100% el 'NFOGRAPHICLOOK v
o1
vs '
S a A A o Ej
(e Search Sound
- 2o AANLABN Sound NGBINTT A Q

FREE SOUNDS

®

Blank slide

Sound Control

ENTIRE
POWTOON

Add voiceover

Search

SayHelloToNew App 23 | &

°o n

00:00 02:06 0

CURRENT
suDE
20f2

@ ain1sunian lwaantan

Add voiceover ):05:00 | 00:56

Premium trial ends

Q38 30

GELRRL 28N

@ uPGRADE

34

Unicorn Chill Dramatic
Holiday: Motiva tional

Say Hello To Ne...
0 |

Slash Bam Boo

01:09 R

Future Marketing
02:00

Time For Two

01:15 Use

AUEANUITUIAAAIUMSANKINGIMERSAVNW (FIFD) ATUEIWNYAARSASS1BWEUA Tel. 02-4199978, 02-4196637 “



[ASUNNSOUSUIBIUNUR 1S

9J Media creation tools for online courses

29 - 30 Mar 2021

% studio | Powtoon x 4+

< c

=® >owTtoon

Slide 2 ¥ of2

01

02

Blank slide

Premium trial ends

93:19¢ 21

© uPGRADE

& powtoon.com/html5-studio/#/edit/dgBbC2Eus00

U CREATE @

= & a %

n13liay Specials

@) Grid B3 Horizontal 16:9) ¥ - —@— + 100%

2 swap Q

I~ CORATEN LISING

aantNald Special theme lua'lag —»

- 1 p

00:05:00 | 00:56

..v.':"

0 ® 00

INFOGRAPHIC LOOK v

Search Specials Q

Choose a special theme

&

FAMILY HOLIDAYS

35

% Studio | Powtoon x  + o = X

< C @& powtooncom/html5-studio/#/edit/dgBbC2EusO0 ﬂ’]slmLuu Speclals = & @ % 0O ® © 00 N Qo » a B
U

=® 2owTtoon

Slide 2 v BEES

o1

02

Blank slide

Premium trial ends.

93:19: 1

O urGrADE

®

@) arid

a Horizontal (16:9) W - —@— + 100%

SAVE PREVIEW SHARE

INFOGRAPHIC LOOK v

2 swar ¥

& ¢

' ~cor -

— . o
aanLaan Special theme NaaiInIg

@ ()

00:05:00 | 00:56

Search Specials Q Ej

MINI-ME

P

=

-

T

Search all looks

.@
:
e,

&
»
E

“ AUgAUITUIAAAUNMSANWINGIMARSIVATW (FIFID) ALUIWNGAIANSASS1BWEIUNa Tel. 02-4199978, 02-4196637



[ASUN1SOUSUIBIUNUR IS0 Media creation tools for online courses 29 - 30 Mar 2021

o [ J
mMsvaunvd lad

37

& studio | Powtoon x 4+ X
<« el () (e R S T e e . - H Q % O ®» 600 N @ :
'
o A 6
:—. POwWTOON R @ 3 Untitled (@] d°ﬁ81wa SAVED  PREVIEW  SHARE EXPORT v
i1
Slide 2 v of2 qq: [} 12 INFOGRAPHIC LOOK v
" @ )ocria ﬂ’]i@ldﬂlﬁ Horizontal (16:9) W - —@— + 100% (4
VS
0,0-5 Search Characters Q Ej
& swap .
E3) & - PHN s
02 « ¥ Add characters s
Swap Flip
Blur v R

MY CHARACTERS

pa

) Et
(A

£0 USING RHAPSODY @
3]
Jr)
=

Blank slide >

@

Color Opacity

EDITABLE

N\
v

OWTOOH

aan + iaiiualae OOO

) 00:05:00 | 00:56 YR v
(»]
INFOGRAPHIC CHARACTERS - FREE

Premium trial ends i . : & i . e v {+ ’/
93:19: 12 ‘ \ Q

ETCH-IT-ALL

@ uPGRADE

AUEANUITUIAAAIUMSANKTINGIMERSAVIW (FIFD) ATUEIWNYAARSASS1BWE1UA Tel. 02-4199978, 02-4196637 “



[ASIN1SoUSUIBIUAURA 1$09 Media creation tools for online courses

29 - 30 Mar 2021

% Studio | Powtoon X 4
& C @ powtoon.com/html5-studio/#/edit/dgBbC2EusOo
=® >owTtoon eoir @
Side 2 v of2

Basic
o1

Zoom In 3 Zoom Out
02

= Wap

= Zoom_a.8_

PRO+
Executive

‘% Fan Up ﬁ Fan Down

ARNLND LAY

Transition

. Slice
@ = @I,
€A Slice

W5 Horizontal B> swiee

Premium trial ends

RS e Y ARG

Split _a.8

@ Circle
Tunnel a.8

@ uPGRADE

39

Untitled

1(16:9) ¥

B ce

© spiralzTech <

[ Slice
o Vertical

& circle spii '

AN slice

= & Q %

- —@— + 100%

v CREATED USING
& powToon

00:05:00 | 00:56

*

0 ® 00

INFOGRAPHIC LOOK v

Search Characters Q HJ

Add characters

©

MY CHARACTERS

|

RHAPSODY

ey I. 1 v
INFOGRAPHIC CHARACTERS - FREE

YT

aft i

|
ETCH-IT-ALL

& studio | Powtoon x +
«

C @ powtoon.com/html5-studio/#/edit/dgBbC2EusOo

:—. POWTOON

® B
@ )arid

Slide 2 v of2

o1
VS
S
ez
Ho & o
— Add scene Blank slide
02
= g
Extend  Save scene
=
Remove slide @
Delete  Duplicate

Untitled

n Horizontal (16:9) W

[

HORIZONTAL f D

E3)

SQUARE

fE

VERTICAL

fO

=)

= & Q %

- —@— + 100%

INFOGRAPHIC LOOK v

Q ]

a A 6
— ARNLABNYBIAVDIF LA

| Blank slide
<

o & a &
Lﬂﬂ%L&l’]ﬁM’]’)’]x‘]UiL’]Mﬁvl.ﬂ@]

A a A (2
ﬂangﬂmmﬂuwaauavlaﬂ
)]

Premium trial ends

Q3f 2t

@ uPGRADE

AN

> p

CREATED USING

%POWTOOH

00:05:00 | 00:56

+

©

MY CHARACTERS

Al

RHAPSODY

Rl I. 1 v
INFOGRAPHIC CHARACTERS - FREE

SRR

ETCH-IT-ALL

a;:

—N

AUEANUITUIAAAUNSANKINGIAERSAVAW (FIFID) ATUEIWNYAARSASS1BWEUa Tel. 02-4199978, 02-4196637



[ASIN1SoUSUIBIUAURA 1$09 Media creation tools for online courses 29 - 30 Mar 2021

S5 studio | Powtoon x  + = 3
&

c e o T o Eh ety - & Q % O ® ®00 e n@

=® sowtoon EDIT @ L 2> Untitled

13
Slide 2 ¥ of2 } L3 INFOGRAPHICLOOK W
@ )arid B3 Horizontal (16:9) ¥ - —@— + 100% L

o1

\&

o?, Search Characters Q

& swap a-

oe Add characters

©

MY CHARACTERS

=) dl 1
ANNLNBLAY Scene
AIULGEILAYY LT el

Blank slide
<

P
ARNLNBLAY Scene

o , %POWTOOH
AILGLING OOO
m')) [ »] ’ ooma0 oo \NFOCRAP:UC‘CH!R‘ACT:RS - FREE'

— I s m s 0: w1 v: + g
03818 57 red T T\ ‘

ETCH-IT-ALL

e
CREATED USING RHAPSODY @

0

8

© UPGRADE

41

& Studio | Powtoon X o+ = X

<« C @ powtoon.com/html5-studio/#/edit/dgBbC2EusOo - & Q % 0 ® % 0 0Q n e N@

:—.POWTOOH EDIT @ l, CA A) Untitled

121
Slide 2 v of2 ) 23 INFOGRAPHIC LOOK v
@ )cria B Horizontal (169) W - —@— + 100% I
o1
vs
oﬁ Search Characters Q Ej
2swar £F
a5 Add characters

©

MY CHARACTERS

. . - Y
Timeline R141IDLAN AN YD qaq@vl,@ 3 U9 g P

xAcy
==y el
() RHAPSODY @
b Ooops... As a Free user,
your Powtoon can only be 3 minutes long. |

To create longer Powtoons, O
upgrade your plan today /pff'\(p\
m,)) b I AN v
[(»] © UPGRADE NOW NFOGRAPHIC CHARACTERS - FREE
‘ =h

03:18 ¢ 54 M AT D ‘e

ETCH-IT-ALL
@ UPGRADE

AUEANUITUIAAAIUMSANKINGIMERSAVNW (FIFD) ATUEIWNYAARSASS1BWEUA Tel. 02-4199978, 02-4196637



[ASIMSaUSUIBIUAURA 1500 Media creation tools for anline courses 29 - 30 Mar 2021

& studio | Powtoon X+ = X
«

C @ powtoon.com/html5-studio/#/edit/dgBbC2EusO0 =% Q% LO® O o0 e »@

=* powToon & ®@ . <N 2> Untitled

=
Slide 2 v of2 AL INFOGRAPHIC LOOK v
@ )arid B3 Horizontal (16:9) ¥ - —@— + 100% "o
o1
VS
09- Search Characters Q EJ
2 swar  LF
o2 Add characters

ARNLANBAY Sound 88N

Sound Control 3 ©

v 35
ENTIRE
POWTOON test.mp3 - - MY CHARACTERS
® : -
S Q > NEW
Blank slide <
00:00 00:26 .
< 100 | o B
— =5 o
SayHelloToNewApp 23 & - f
RHAPSODY @
] o: "
00:00 02:06
— O o
CURRENT At ot O I O
i suoE voiceover X .
20f2 00:56 1 i v Jg

INFOGRAPHIC CHARACTERS - FREE

4 18s 19s 20s + +
v - v;c @b {a/l
SERR UMV | |

ETCH-IT-ALL

(113

>~

43

S5 studio | Powtoon X 4+ = o3
&«

C @& powtoon.com/html5-studio/#/edit/dgBbC2Eus00 =& Q% LO® G600 e n@

=® >owrtoon eomr ®

: =R
Slide 2 ¥ of2 A% INFOGRAPHIC LOOK v

@ )i B3 Horizontal (169) ¥ - —@— + 100% 8“2

o1

Search Scenes Q a]

SITUATIONS

Blank slide

=
—

[
e
- P

™ "

B 566

00:05:00 | 00:56

)]

Premium trial ends

03 : 18 : 46

DAYS  HOURS  MINS

Q@ uPGRADE

“ AUEANUITUIAAAUNSANKINGIAERSAVAW (FIFID) ATUEIWNYAARSASS1BWEUa Tel. 02-4199978, 02-4196637



[ASIN1SoUSUIBIUAURA 1$09 Media creation tools for online courses 29 - 30 Mar 2021

& studio | Powtoon X -+ = X
<« C @ powtoon.com/htmi5-studio/#/edit/dgBbC2EusOo - & Q W e & 9 00 N @ * ‘3 :

itl i EXPORT v
a0 e g Proviow

IC LOOK v
- & Q % 0® %00 ORI < T

-3

Slideshow (_®) Movie Is your Powtoon ready? EXPORT

Premium trial
03: 18 :
avs | Hours

O urcra

g
&

02

AR

Studio | Powtoon x 4+ = X

=® sowToon bd T Share

03+ 18 40

C @ powtoon.com/html5-studio/#/edit/dgBbC2EusOo -

0. o *@G:

SR

Slide 2 ¥ of2 x

Share your Powtoon with others to view

Want to remove all watermaks?

GO PREMIUM

SITUATIONS

=

Blank slide

000
| 000
000

C~ CREATED USING
& PowToon ‘

00:05:00 | 00:56

)

Premium trial ends

© UPGRADE

AUEANUITUIAAAIUMSANKTINGIMERSAVIW (FIFD) ATUEIWNYAARSASS1BWE1UA Tel. 02-4199978, 02-4196637



[AsIN1SoUsSUIBIUNUR 1560 Media creation tools for online courses 29 - 30 Mar 2021

& Studio | Powtoon x  + = X

€« C @& powtoon.com/html5-studio/#/edit/dgBbC2EusOo - Q N Q@ * ‘3 :

=® sowTooON EDIT ® A L&H{& Publish

SHARE PUBLISH v

Slide 2 v of2 } e

@ ) cria B3 Horizon tal (16:9) W - —@— + 100% at 2 Share Link

Q

o1

VS ¥e 4, Download Video (MP4) @
ez Facebook Group search §
| & Powtoon
02 Twitter > Savd
&
ot - \%{ O Youlube
"ﬂ Q". i Send by Email
. ’jﬁﬂ _. '0se 3y @8 Download PPT
) SWAP
Wisti
sta J-  Download PDF
E] £} Facebook Page

Blank slide

Vimeo
w SlideSh
o o

=9 e
¢ LinkedIn A
: 5
== Facebook Ads <ie .
HubSpot

) [»] ’ <> Embed Video /,\/_'/ @ Dﬁ
A13 Publish azﬁﬂﬂ‘”mwwzLu%ﬂlﬁwamﬁu
89n17 export 1% MP4 %38 SlideShare 9¢@ 84318134l AN

47
% studio | Powtoon x 4 = X
<« ¢ (8 onmon o5 stdiof /i dgBbe2EmR00 "% Q% LO® O OoOO N @
1y g
Usznguiiaeh Qo | (D)
¢ @378 lWaN22 Publish
=

Detail

s ° Add Description ° Add Tags

=1

EE Other W
Category

6 Public v

#20819n13 Publish AanLy next
1% PowerPoint e

“ AUgAUITUIAAAUNMSANWINGIMARSIVATW (FIFID) ALUIWNGAIANSASS1BWEIUNa Tel. 02-4199978, 02-4196637



[ASIMSOUSUIBIUAURA 1500 Media creation tools for online courses 29 - 30 Mar 2021

5 studio | Powtoon X 4 = X

< C @ powtoon.com/html5-studio/#/edit/dgBbC2Eus0o =% a % LO®® o0 OO < I ¢ I

° Details | a Quality

PRO a O Remove watermarks . Include watermarks

Watermark
@ Standard 480p @ =
o Q HD Quality
y 720p ©
Quality g = D

8 O FullHD 1080p 0o

@28¢19n17 Publish [ @dntda Download

v PowerPoint Q

49
5 Powtoon - test X  + = X
< C @ powtoon.com/online-presentation/dgBbC2EusOo/?mode=movie ®aw 40 &® % 00 N o *» ‘3 H
m&\s\ ST§YCAT PN - i /r Get our e : :
z Lﬂaﬂ@;‘]]LLU‘]J Slideshow Pro+ plan 50% off
A . - i
%POWTOOO WORKSPACE  DISCOVER NI MOVle ﬂaﬂ‘ﬂqu Edlt Powtoon 55
A o

test l Lllﬂ@lﬂ\'iﬂ’]ﬁLLﬂwL?l

By srvvnites1965 | Updated: Aug. 30, 2020, Siideshow (@) Movie

8:37am.

SHARE THE AWESOMENESS

f v in = &

Want to remove the

Powtoon branding?

UPGRADE PLAN

: N3 bINS 1281 Publish az@aa1sdin1aay E

£N

AUEANUITUIAAAIUMSANKINGIMERSAVNW (FIFD) ATUEIWNYAARSASS1BWEUA Tel. 02-4199978, 02-4196637



[ASIMSaUSUIBIURURA 1§04 Nesdisseneati ovotes Fsofo farndime cad Uesehers 29 - 30 Mar 2021

% Powtoon - test

€« c

51

X

@ powtoon.com/online-presentation/dgBbC2Eus0o/?mode=movie

& a % (s JNGY

Choose how you'd like to publish your Powtoon: test

Update your personal
Powtoon player page

OR

a
L PDF

CONTENT COMMUNITIES

Facebook  YouTube Vimeo

‘g B8

PLATFORMS

PPT

Wistia  HubSpot

New!
—>

Ads Manager

® 0o 0

EMBED EMAIL

e @

X

& &

|— Compose

Inbox
Starred
Snoozed
Important
Sent

Drafts

Categories

‘

s 9 ®PVVOoe *x0O

Boxer

B Todo

Meet
B Start a meeting

B Join a meeting

Hangouts

.‘!i'ﬁim

(‘3 sied516
No one has joined

cH

= M Gmail

™M Your Powtoon was published - st X a7

& mail google.com/mail/u/2/?tab=wm&ogbl#inbox/FMfcaxw IXfmWrMZnBnSmhO7KImRS7nWO +

T2UUUTEUIANALESALAD 92F1013D Download ¢

Q  Search mail

€« O 0§ & ©

A18819n15 Publish
vl PowerPoint

e &

10f553

+

+

2 B

Congratulations!
Your Powtoon is ready!

Hi 9554w,
Your Powtoon "test", has been successfully published

and is ready to be shared with the world!

View your Powtoon:

https://www.powtoon.com/online-presentation/

dgBbC2Eus0o/test/ To download a PowerPoint file of

your Powtoon, click here:

DOWNLOAD AS POWERPOINT

® 0 0

)
® @
> =~

“n@m@mmnﬁumﬁm mmwmamawmwm@mmmnmmam’aiaaﬁa@@@auaz-mmsamm




[ASIMSOUSUIBIUAURA 1500 Media creation tools for online courses

29 - 30 Mar 2021

=]

File  Home Isert Design s Animations

slide20f3 [2 English (United States)

1598776639.pptx - Protected View - Saved to this PC

SlideShow  Review View Recording  Add-ins

Help EndNoteX9 Acobat @ Tell me what you want to do

%

28819117 Publish 1% PowerPoint

% Studio | Powtoon x + = X
& > C @ powtoon.com/html5-studio/#/edit/dgBbC2EusOo B a%x LO® 6o W N
» YouTube | Upload To YouTube X

A18819n15 Publish
&
A4 Youtube

0 |

= 3
@/\ Details | (3) quaiity

Aan + Add Account

8

° Add Account

CANCEL “

[l

“ AUgAUITUIAAAUNMSANWINGIMARSIVATW (FIFID) ALUIWNGAIANSASS1BWEIUNa Tel. 02-4199978, 02-4196637



[ASIN1SoUSUIBIUAURA 1$09 Media creation tools for online courses 28 - 30 october 2020

5 studio | Powtoon X 4 — a %

G sign in - Google Accounts - Google Chrome = @

W Q % O ® 600 K- J0 ¢ I

@ accounts.google.com/o/oauth2/auth/oauthchooseaccount?client id... &

G Signin with Google = » YouTube | Upload To YouTube

o Type | w:é\; Details | \fé\/\ Quality
Choose an account B R

to continue to PowToon

C o
A a A o
Ve Vanich: hai
@ e \Aan account NiBanle9ny Youtube
° sihe516 shee
sheesihe516@gmail.com
. srwnites1965@gmail.com
° teacher teach
teacherteach359@gmail.com

Vorawan Vanicharoenchai
vorawanv09@gmail.com

° Add Account

@ Use another account

To continue, Google will share your name, email address,
language preference, and profile picture with PowToon. Before

cANCEL “
using this app, you can review PowToon's privacy policy and

terms of service. '-Jaﬂl’]\jﬂ’-]j PUb|ISh
&
English (United States) ~ Help  Privacy  Terms U YO u t u b e e

55

% Studio | Powtoon X 4 = o X
G Sign in - Google Accounts - Google Chrome: — (] 5 ® Q % 0o % ® 00 WO * @ .
& accounts.google.com/signin/oauth/consent?authuser=08part=Ali8... &I .

G signin with Google > YouTube ‘ Upload To YouTube

o Type (é] Details | (5] Quality
PowToon wants to access your Google B R
Account
@ vorawanvanemahidol.edu AAd o

NN 9yl Youtube

This will allow PowToon to:

o
channel 484 account 7

@ Manage your YouTube account @
FL COS v '
LINLDT CABIRININD U
Make sure you trust PowToon

You may be sharing sensitive info with this site or app. Learn about
how PowToon will handle your data by reviewing its ° Add Account
terms of service and privacy policies. You can always see or
remove access in your Google Account.

Learn about the risks

Aan Allow 198£19113 Publish
English (United States) v Help  Privacy  Terms £ 5
f ! U1 Youtube e :

AUEANUITUIAAAIUMSANKINGIMERSAVNW (FIFD) ATUEIWNYAARSASS1BWEUA Tel. 02-4199978, 02-4196637




[ASIN1SoUSUIBIUAURA 1$09 Media creation tools for online courses 29 - 30 Mar 2021

%5 studio | Powtoon x + = X
<« C @ powtoon.com/htmi5-studio/#/edit/dgBbC2Eus0o B a%* 4HO® O o0 W @
» YouTube | Upload To YouTube X
° Type | \:é\/\ Details | (5\) Quality

You have authorized Powtoon to access the following YouTube accounts
on your behalf. Please select the one to use for this export.

® «

A .
———— & Addiaccourt Ldan3yuuy Privacy
REMOVE U
Public
@ Public Unlisted
Privacy
Private

A18819n15 Publish m

& a_ :
2% Youtube AaNUY next o
57
% studio | Powtoon X 4 = X
€ C @ powtoon.com/html5-studio/#/edit/dgBbC2EusOo W a% 40O0® G 000 oo N 43 2
> Youlube \ Upload To YouTube X

501
° Type | e Details | (3) auaity

——— @78 lWaNaz Publish

[

Details L
o Add Description o Add Tags
o=
= Other v
Category

8 Public v

Powtoon Privacy

#18819n13 Publish ] eandwnext
£ 3
21 Youtube e

cCo

m AUgAUITUIAAAUNMSANWINGIMARSIVATW (FIFID) ALUIWNGAIANSASS1BWEIUNa Tel. 02-4199978, 02-4196637



[ASIN1SoUSUIBIUAURA 1$09 Media creation tools for online courses 29 - 30 Mar 2021

% Studio | Powtoon x  + = e
€ C @& powtoon.com/html5-studio/#/edit/dgBbC2EusOo & & ¥ 0O ® 00 N Qo *» ‘3 H
» Youlube | Upload To YouTube X
Q - @ oo © aawy Free users have a max length of 3

minutes for Powtoons in HD

quality (720p).

o] 8 :
O Remove watermarks . Include watermarks Up tO 3 mins (HD)

Watermark

813130 Export kUU HD 720p
Q Standard 480p E = . -
A3 El']’JVL&ILﬂu 3 %N

®) ® Hoauaity 7200 [ g

Quality
a O FullHD1080p 8o @ (]

By clicking Upload Powtoon, you certify that the content you are uploading complies with the YouTube Terms of Service
(including the YouTube Community Guidelines) at https://www youtube com/t/terms. Please be sure not to violate others
copyright o privacy rights.

@18819n13 Publish aanila Upload
& ! ;
Y% Youtube 0

& Powtaon - test x 4+ o X
<« C @ powtooncom/online-presentation/dgBbC2Eus0o/Zmode=movie#/ ® Q % 0 ® 600 W@ :

DN Stuck at home? r Get our o
/ Pro+ plan 50% off " *

FREE

Y o & a i o A
11 upload &1t332 92N mail LIINT TILID

& powT¢ 7 (2 SRVVNITES1965
4 1w laluiwy My channel 6
U U Prﬂlm'u»:{
tn’mleu:’/7
Congratulations!
Your Powtoon has been published successfully. We'll notify you by email as soon as the export to YouTube is complete. ~
If this Powtoon contains live video, the export process may take a bit longer. Aa 1 .
aanilau Edit Powtoon
Wadaanisurtly
test
By srvvnites1965 | Updated: Aug. 30, 2020, Sideshow @) Movie
9:07 am.

Lﬁaﬂ%LLUU Slideshow

#1358 Movie

SHARE THE AWESOMENESS

f v in = &

60

AUEANUITUIAAAIUMSANKINGIMERSAVNW (FIFD) ATUEIWNYAARSASS1BWEUA Tel. 02-4199978, 02-4196637 102




[ASIN1SoUSUIBIUAURA 1$09 Media creation tools for online courses 29 - 30 Mar 2021

™M Your Powtoon was published-s X = = X
€« C @ mailgoogle.com/mail/u/2/?tab=wm8ogbl#inbox/FMfcgxwXfmWrMZnBnSmbQZKIMRSZnWQ * 0 ® © 00 e @
. =3 v a v o
= M Gmai Qs JrUUYTTUIANALETILRD ﬁ’]&l’]iﬂﬂaﬂ@luu Youtube vl(ﬂ o s = @
< a 0 = © ¢ B 1 0f 553 > mm-
F compose
[J Inbox 20
%  Starred
(]
© Snoozed
» Important
> Sent . q e
B o Congratulations!
» B Categories Your Powtoon is ready!
= Boker Hi 2515501,
B Todo o
Your Powtoon "test", has been successfully published
Meet to YouTube and is ready to be shared with the world!
B¢ Starta meeting
B Joina meeting Here is the URL to your YouTube video:
Hangouts
[ , be.com/watch?v=
> 1 . 5
@8 8139N173 Publish VST TP (eI
§2 https://www.powtoon.com/online-presentation/
U4 Youtube dgBbC2EusOo/test/ 5
61
™M Your Powtoon was published - s X O test- YouTube X + = X
C @ youtube.com/watch?v=2yilzJ0selM&rel=08&utm_source=broadcast&utm_medium=email&utm_campaign=Transactional-Publish-success Y 0O & ® 00 HOBK B =) @ H

— H .
= E3Youlube Aum Q
Viral Feed

3@ 339 a1 afs - 3 Diiua

Simon & Garfunkel - Greatest
Hits (HD) (Video Collection)...
MUSIC LEGENDS

A3 6.1 8w Afs - 3 Tiluan

| 4vhdatloazuuios ambavds

\ilaagTwn Basic Yoga inbed f...
Ki . art yoga - online yoga & lifest.

130 5.6 uau ae - 1 fiuan

falnateligin - 37u sunan
Cover by Sandy

Mozarz Academy

M 51 ad - 4 Alaniddnn

1asousn nautiiag
- 1ifwalwai Thai Lion Air | wila...
Mai Jainoon @

130 9.8 uau aFs - 1 Miuas

> M ) 011/017

H[]W Tu USE How to Use Google Jamboard

"= for Remote Teaching
GOOGLE JAMBOARD  new EdTech Classroom
test A FORREMOTE TEACHING nnsq 3.7 wa afo - 2 auilinun

@ hirflumsisay

Top 100 Free Stock Videos 4K
Rview and Download in Pixaba...

Free Stock Video
M3 9.3 uau aFe - 1 Hiuan

“ifinisq - 30 &.A. 2020 0 Ho A uw = dduia

HAaa 5 au

iﬁ Vorawan Vanicharoenchai @T’Ja qu\jﬂ’]i PUblISh j.lu YOUtU be

62

103 AUgAUITUIAAAUNMSANWINGIMARSIVATW (FIFID) ALUIWNGAIANSASS1BWEIUNa Tel. 02-4199978, 02-4196637




[ASIN1SoUSUIBIUAURA 1$09 Media creation tools for online courses 29 - 30 Mar 2021

AN b capture recording screen

& Powtoon Workspace x 4+ X
€« C @& powtoon.com/new-dashboard/#/blank?toolbarState=default&toolbarWidget=myPowtoons & QA X & *» :
i Toolbox =
S @ Create a new video
. My Powt
Design. Create. Share. ‘ @ yisowioons
HOME

+ dauuzihawiunisu

Zoom Meeting --
TEMPLATES

IMPORT

(D creaTE % 16:9

Learning Cantar

Capture Horizontal Square

() Apps & Integrations

? oen 7

Help More Tour

capture recording screen

( W PRICING >

Vorawan o
@ Vanicharoenchai

3 Giftexpires in:

02:22: 01

DAYS HOURS MINS

AUEANUITUIAAAIUMSANKINGIMERSAVNW (FIFD) ATUEIWNYAARSASS1BWEUA Tel. 02-4199978, 02-4196637 m



[ASIN1SoUSUIBIUAURA 1$09 Media creation tools for online courses 29 - 30 Mar 2021

& Powtoon Workspace X & Powtoon Workspace x 4+ = X

< C @ powtoon.com/new-dashboard/#/blank?toolbarState=default&toolbarWidget=myPowtoons & aQ w * "8 :

Get your message across with Powtoon Capture

HOW TO USE

OWTOON
CAPTURE

RECORD x ll °
<) & &

v .
@04 add chrome extension

5 Powtoon Workspace % | & Powtoon Workspace X & Powtoon Capture -Screenand ' X 4 = X
C @& chromegoogle.com/webstore/detail/powtoon-capture-screen-an/haphbmapkindhnldhjafhfflbjodpfmn wax @ :
~— chrome web store * vorawan.van@mahidol.edu v

Home > Extensions > Powtoon Capture - Screen and Webcam Recorder

G4 Powtoon Capture - Screen and Webcam Recorder
Offered by: powtoon.com
| ivity | & + users 3
Y% %k % & 21 | Productivity | & 40,000 ARN add tO Chrome
Overview Privacy practices Reviews Support Related

HOW TO USE

OWTOON

105 AUgAUITUIAAAUNMSANWINGIMARSIVATW (FIFID) ALUIWNGAIANSASS1BWEIUNa Tel. 02-4199978, 02-4196637




[ASIN1SoUSUIBIUAURA 1$09 Media creation tools for online courses

29 - 30 Mar 2021

& Powtoon Workspace X | & Powtoon Workspace X @ Powtoon Capture - Screenand V. X

o

C @ chromegoogle.com/webstore/detail/powtoon-capture-screen-an/hgphbmgpkindhnldhjafhfflhjodpfmn

C4  Add "Powtoon Capture - Screen and Webcam

£~ chrome web store Recorder"?

It can:
Home > Extensions > Powtoon Capture | Read and change all your data on the websites you vist
Display notifications

% Powtoon Capture p— e |

Offered by: powtoon.com

% % % % & 21 | Productivity | & 40,0

Aan add extension

Overview Privacy practices Reviews Related

Support

HOW TO USE

OWTOON

[m]

W ax »@ :

* vorawan.van@mabhidol.edu v

Checking...

% Powtoon Workspace x | & Powtoon Workspace X | @ Powtoon Capture-Screenand V' X 25 Powtoon Workspace

&

() HoME

& powtoon.com/new-dashboard/#/home?toolbarState=defaulttoolbarWidget=myPowtoons
Hi Vorawan!

(rrEE )
L)

What video would you like to create today?

Cz
TEMPLATES & CRPTBLéiE
’
IMPORT O"‘ - ]
A
CREATE 7 ’g ] < 4
N
? - P
Help More Tour

< W PRICING )
Administrative Staff
Vorawan .

& vanicharoenchai

5 Giftexpiresin:

Featured Templates
03:23:36

DAYS HoURS  MINS New

§% Premium templates Most Popular  Virtual Events

#41 Custom

= X
AN - E’@
Extensions
Full access pXeanD
These extensions can see and change information on
this site,
@ EndNote Click - Formerly Koper.. n H :

I & Powtoon Capture - Screen and... II;I :

¢  Manage extensions

\ian Powtoon Capture

Learning Center

Apps & Integrations

@

Powered by
%5 PowToon

AUEANUITUIAAAIUMSANKINGIMERSAVIW (FIFD) ATUEIWNYAARSASS1BWE1Ua Tel. 02-4199978, 02-4196637



[ASIMSaUSUIBIUAURA 1500 Media creation tools for online courses 29 - 30 Mar 2021

%5 Powtoon Workspace £ \ % Powtoon Workspace e | & Powtoon Capture - Screenand V. X &5 Powtoon Workspace x  +

C' @ powtoon.com/new-dashboard/#/home?toclbarState =default&toolbarWidget=myPowtoons
% capTURE

@‘;;]

Screen Screen
& Cam only

aan Allow

= X

S5 Powtoon Workspace @® x +
= B Q% ¥ *-zPaused :

< C' @ powtoon.com/new-dashboard/#/home?toolbarState =default&toolbarWidget=myPowtoons

% carTURE

Record Present

Lﬁ'aﬂgﬂuuuﬂ’ﬁﬁ’uﬁnﬁﬁwa éﬁ

Q' Microphone audio
Design Video

Video Frame

-~

n&a Record

00:00:00

107 AUgAUITUIAAAUNMSANKINEIAMARSIVAIW (FIFID) ALUIWNGAIANSASS1BWEIUNa Tel. 02-4199978, 02-4196637




[ASIN1SoUSUIBIUAURA 1$09 Media creation tools for online courses

29 - 30 Mar 2021

& Powtoon Workspace

& c

@)

&

() Home

TEMPLATES
IMPORT

CREATE

Help More

( W PRICING )

o Vorawan

1§ Giftexpiresin:

02:23:35

DAYS HOURS MINS

~
@ Vanicharoenchai

x  +

@ powtoon.com/new-dashboard/#/home?toolbarState=default&toolbarWidget=myPowtoons

Get More for Less 44% Off

H | Vo FCI Wd r Share your screen

Choose what you'd like to share.

wants to share the contents of your screen,

What video would y Your Entire Screen Application Window Chrome Tab
(
{ e ————— IERTRRy v
 — S G QIR <1eov——t]

camera — ZE

WBWanNNIURANLUL Your Entire Screen

Share

-

Cancel

Zeo i TP | “

Administrative Staff

GET IT NOW

= [m]

=& ar T @)

Toolbox

§ Customize ‘ ‘ @ My Powtoons

Learning Center

|
e (&) Apps & Integrations

Powered by

% 2owToon

% Powtoon Workspace

€ c

(e

&

() HoME

J

TEMPLATES
IMPORT

CREATE

Help More Tour

( W PRICING >

o Vorawan
& Vanicharoenchai

15 Giftexpiresin:

-

02:23

HOURS

x 4+

& powtoon.com/new-dashboard/#/home?toolbarState=default&toolbarWidget=myPowtoons

Get More for Less 44% Off

H I Vo rO WO r Share your screen

chrome-¢
Choose what you'd like to share.

Your Entire Screen Application Window Chrome Tab

wants to share the contents of your screen,

What video would y

@ Powtoon Workspace - G...

.

@ PowtoonManual. pptx -

media creation tool

LY
",

A2/ e o (ST “

Administrative Staff

Share

-

Cancel

id

l.i»m-lv ii_

GET IT NOW

WannsuuAnuuY Application Window

= a

& e r T @)

Toolbox

f Customize ‘ ‘ @ My Powtoons

\ eaming Canfar

F (5) Apps & Integrations

Powered by
% PowToon

AUEANUITUIAAAIUMSANKINGIMERSAVIW (FIFD) ATUEIWNYAARSASS1BWE1Ua Tel. 02-4199978, 02-4196637 m



[ASuN1soUSUIBIUNUR 1509 Media creation tools for online courses

29 - 30 Mar 2021

& powT00 #8819 VDO NUBNNUEAD s ericne suprosr

Mar 23, 202§ Powtoon Capture recording

By vorawanv09 | Updated: March 23, 2021,
144 pm.

Less  44% Off GET IT NOW f v in

Toolbox

HiVorawan!

¥

What video would you like to create foday?

| o % PowToon

Capture!

[ —
Q:d @

001011 | powroon @)

& Powtoon Workspace X 5 Powtoon - Mar 23,2021 Powtoo. X 4 = X
C @ powtoon.com/online-presentation/f7MriBqOLqw/?mode=movie#/ W Q% ¥ ® = :
FREE a

SHARE THE AWESOMENESS

avideo like this
with Powtoon

ﬁ & 21 Easily record

Get Started

81U1I0UBANAINE1IVBS VDO "lm”ggaq@ 0% o

» responsibility of

VORAWANV09

1§ Giftexpires in:

02 :23: 34

DAYS HOURS  MINS

&

L]

73

n13lgiuy Import

74

m AUEANUITUIAAAUMISANKINGIERSAVAW (FIFID) ATUEIWNYAARSASS1BWeUa Tel. 02-4199978, 02-4196637



29 - 30 Mar 2021

[ASIN1SoUSUIBIUAURA 1$09 Media creation tools for online courses

% Powtoon Workspace x  +

< C @ powtooncom/new-dashboard/#/import?toolbarState=defaultétoolbarWidget=myPowtoons

Toolbox

&S @ Import

@ My Powtoons

814150 import W& ppt 18118l Powtoon

HOME
TEMPLATES
CREATE
Import
PPTX file
ster
LoD §13190 add-in Powtoon
v ' . rations

Y - Download Powtoon Plugins L?lﬁ&lﬁlﬁluiﬂil,mi&] PowerPoint
(Cw rmene )
& Veharsrcta i Powtoan for

Adobe Microsoft

PowerPoint
Powered by

Photoshop
%5 2owTo0n

( pownLoAD DOWNLOAD

i3 Giftexpiresin:

@22

YS  HOURS

% Powtoon Workspace x E¥ Powtoon | Convert Presentations X
C @ appsourcemicrosoft.com/en-us/product/office/WA1043820012tab=Overview 3]
B Microsoft | AppSource More ~/ O Search
Apps > Powtoon | Convert Presentations to Video
Powtoon | Convert Presentations to Video
" Powtoon limited
/ @ PowerPoint
¢ 3.5 (103 Ratil
sowtoon XK i 35003 ainge)
Pricing Additional purchase may be required
'
2 . ~ .
, ‘ ‘ AanN Get it now tiWa add-in Powtoon
Overview  Reviews  Details + support
anlaluly i

Convert your PowerPoint presentations ir L"U’] 3‘]’] a u i LLﬂsa‘l POWGFPOI nt
Easily transform your presentations into videos in just one click — straight from PowerPoint. Once your new video is
ready, enhance it with Powtoon’s royalty-free footage, animation, characters, fonts, music, voiceover and more in the
Powtoon Studio.
In order to use this Add-in, you must have a Powtoon account.
Benefits:

o Create breakthrough internal & external video communication

* Easily produce your own videos — no design or tech skills necessary

« Add awesomeness to your PowerPoint presentations

Waiting for appsource microsoft.com.. ~

AUEANUITUIAAAIUMSANKINGIMERSAVIW (FIFD) ATUEIWNYAARSASS1BWE1Ua Tel. 02-4199978, 02-4196637



[ASuN1soUSUIBIUNUR 1509 Media creation tools for online courses 29 - 30 Mar 2021

S5 Powtoon Workspace x B Powtoon | Convert Presentations X =

C @ appsourcemicrosoft.com/en-us/product/office/WA1043820012tab=Overview

One more thing ..

; Powtoon | Convert Presentations to Video
By Powtoon limited

This app requires some basic profile information. We have pulled your Microsoft Account
data to help you get started. AppSource will save your information for next time.

Name Vorawan Vanicharoenchai

Work email = vorawan.van@mahidol.ac.th

Job title
Company Mahidol University
Country / region Thailand

Phone number « 028496113

1 give Microsoft permission to use or share my account information so that the
provider or Microsoft can contact me regarding this product and related products. |
agree to the provider's terms of use and privacy policy and understand that the rights
to use this product do not come from Microsoft, unless Microsoft is the provider. Use
of AppSource is governed by separate terms and privacy.

You're signed in as Vorawan Vanicharoenchai (vorawan.van@mahidol.ac.th).

v =g 2 ¥ ., - 4
winaafazudsingld signed in n3ld

l15un33 Microsoft @28 email la

& Powtoon Workspace x B Install Powtoon | ConvertPresen: X =
< C @ store.office.com/addinsir I ?rs=en-US8&assetid= 104382001 &correlationld=28d45841-9250-4d4c-93fc-ec97afa563b6 3]
B Microsoft | Office Store Add-ins Templates  Support All Microsoft v Search O

Apps > Powtoon | Convert Presentations to Video > Launch

Powtoon | Convert Presentations to Video
Powtoon limited

e

PowToon

Get started with the add-in:

ﬂ: Open in PowerPoint fan Open in PowerPoint

This add-in works in: PowerPoint 2013 or later on Windows, PowerPoint 2016 or later on Mac, PowerPoint 2016 or later on
Windows, PowerPoint on the web.

If you don't have the above, try using Office Online.

Can't find the add-in within Office

Enable editing, trust the add-in and look for the add-in in the insert tab under "My Add-ins'.
Click here for step by step instructions

@ Need more help

For more on install Office add-ins, view our help documentation

7Q

AUEANUITUIAAAUMISANKINGIERSAVAW (FIFID) ATUEIWNYAARSASS1BWeUa Tel. 02-4199978, 02-4196637




[ASuN1soUSUIBIUNUR 1509 Media creation tools for online courses 29 - 30 Mar 2021

% Powtoon Workspace X B9 Install Powtoon | Convert Presen X +

< c @ store.office.com/addinsinstallpage.aspx?rs=en-US8assetid=WA104382001&correlationld=28d45841-9250-4d4c-93fc-ec97afa563b6 ® & ¥

Open PowerPoint?

https://store.office.com wants to open this application.

s
Can't fir [ Always allow store.office.com to open links of this type in the associated app

Enable editir
Click here fg

A&N Open PowerPoint Y

ns - Wiki

Ficuury

Add-ins
1. To find your add-ins, click on the 'Insert' tab in the top 2. Click "My Add-ins' to view your installed add-ins. On
ribbon of your Office application some versions of Microsoft Office, this button may read "My
Apps'
Need more help
r y  For more on install Office add-ins, view our help documentation
@ English (United States) Sitemap Contact Microsoft Privacy Terms of use Trademarks Safety & eco About our ads © Microsoft 2021

79

AutoSave Powtoon---Convert-Presentat... » £ search Vorawan Vanicharoenchai

Design  Transitions ~ Animations ~ Slide Show Review View Recording Add-ins Help EndNote 20  Acrobat 12 Share - Comments

s e D 2l B Get & | AT Q O | S

File Home

i |

New Reuse Table Pictures Screenshot Photo Shapes Icons 3D  SmartArt Chart Forms My Add . Zoom Comment Text Header WordArt Equation Video Audio Screen Powtoon
Shide v Slides v - v Album~ v Models v GRS - Box &Footer ~ 3] v - v Recordingl] Export
Slides Tables Images lllustrations Forms. Add-ins Links. Comments Text Symbols Media Powtoon A
I 6 1 5 I 4 I 3 { 2 I 1 I 0 I 1 { 2 I 3 1 4 I 5 I 6 !

1 =) dl

= — - aan Powtoon Export LN Export

- 2 Powtoon | Convert Presentations to Video VL 6 o vl, Y I
Wa ppt 117 1 g3lsnTy Powtoon

Launch the add-in

After you install the add-in, you can launch it by choosing the add-in button on the Insert tab

Add-in 984 Powtoon 9%

On the Insert tab

luusngfiay insert

- g

Pontoon

Need more help?

Return to your intemet browser or copy this link into your browser;
h ffice.com/dest i d68-8286-43ea-943b-. 1b&ai=WA104382001&rs=en-US&ta=HE

side1of1 [} English (United States) 1= S g - 'l + 8%

on

AUGANITUIAARTUNSANBIINGIFNARSAVAIW (FIFID) ACUZIWNEAARSASS16WENUNA Tel. 02-4199978, 02-4196637 112



[ASuN1soUSUIBIUNUR 1509 Media creation tools for online courses 29 - 30 Mar 2021

onvert-Present: O Search Vorawan Vanicharoenchai - X
file  Home Insert Design Transitons Animations Slide Show Review View Recording Add-ins Help EndNote20 Acrobat & Share & Comments
e — N~ [ =5 + B ) >~
O S & BEO D 68 s O | [ 2T OO G

s N o] Bd @i O %9 B Ao | B cetadsins [A] T O D) b | &
New Reuse | Table | Pictures Screenshot Photo | Shapes lcons 3D  SmartArt Chart | Forms | oy 00| Zoom Comment | Text Header WordArt Equation Video Audio Screen | Powtoon
Slide Slides - - v Abumv | v Models v Ca v Box &Footer v & ~ v~ Recoding | Bxport

Slides Tables Images. Ilustrations. Forms Add-ins Links Comments Text Symbols Media Powtoon ~

N R e R e e R I e O e e W E W R SR, IS

1 Powtoon Export R X
2 - Z_ Powtoon | Convert Presentations to Video

Launch the add-in

After you install the add-in, you can launch it by choosing the add-in button on the Insert tab

On the Insert tab

% PRESENTATIONS INTO
= ENGAGING VIDEOS

Pontoon

Need more help?

Return to your internet browser or copy this link into your browser: a . .
| SUSSSENSENSI e afin Loginin to Powtoor

side1of3 [}  English (United States)

81

AutoSave onvert-Present: £ Ssearch Vorawan Vanicharoenchai B - g X
File Home Insert Design Transitions ~Animations Slide Show  Review View Recording Add-ins Help EndNote 20  Acrobat & Share 7 Comments
sl el o 5 ] s B \ ] o
D @ Bl i B % P o) | B cernsains [ A T Q W o &
New Reuse | Table | Pictures Scre Audio  Screen | Powtoon
Slide~ Slides v v Powtoon Export - https;//www.powtoon.c ins/ppi h- PABYACAAJGAIACIAMQAIADAAPABOACAAYQBPAGQAPQAIAFCAQQAXADAANAAZADGAMGAWADA... X v Recording | Export

Slides Tables Imf Media Powtoon ~
1 kport v X

% PowToon | §

2 ]
3 Log in to Powtoon
New to Powtoon? Sign up
3
; i
e VIDEOS & DYNAMIC
e PRESENTATIONS
° G Google 1] office 365 IGAGING VIDEOS
= Bl Facebook in Linkedin

Enterprise account

G IN TO POWTOON

A8N Login in 628 email 289 google

slide1of3 [}  English (United States)

7

AUEANUITUIAAAUMISANKINGIERSAVAW (FIFID) ATUEIWNYAARSASS1BWeUa Tel. 02-4199978, 02-4196637




[ASIN1SoUSUIBIUAURA 1$09 Media creation tools for online courses 29 - 30 Mar 2021

Powtoon---Convert-Presentat. O Search Vorawan Vanicharoenchai
file  Home Insert Design Transitions Animations Slide Show Review View Recording Add-ins Help EndNote20 Acrobat % Share T Comments
0 E S e & DO B0 A O EB 48 TG L1 |
= 5 | s | FD B 4E ) |
[in l el ol O % = A5 | Biceadsins | [2O %] [A] L (9 ) i | &
New Reuse | Table | Pictures Screenshot Photo | Shapes lcons 3D  SmartArt Chart | Foms | oy 0o | Zoom Comment | Text Header WordArt Equation Video Audio Screen | Powtoon
Slide v Slides v ~ v Albumv | v Models ¥ SIMy v Box &Footer ~ &I B v v Recording | Export
Slides Tables Images llustrations. Forms Add-ins Links. Comments Text Symbols Media Powtoon ~
I 6 1 5 I 4 I 3 I 2 I 1 I 0 I 1 I 2 I 3 I 4 ' 5 ' 6 ! -
1 Powtoon Export S
2 - 2 Powtoon | Convert Presentations to Video
* an Export all slides t t
: Launch the add-in . o EXPORT ALL SLIDES TO
3 A v [ POWTOON

; Heneensesiamenan i cesnater 131 9 G 8NN Export slides NInua

On the Insert tab

% SLIDES TO POWTOON

Pantoan

SAVE SELECTED SLIDES
& IN ‘MY SCENES' LIBRARY

Need more help?

Return to your internet browser or copy this link into your browser:
i b

= 1b&ai=' 104382001 =en-US&ta=HE
ES
¥
slide 10f3 [}  English (United States) + 73%
Powtoon-——-Convert-Presentat £ Ssearch Vorawan Vanicharoenchai
File Home Insert Design Transitions ~Animations Slide Show Review View Recording Add-ins Help EndNote 20  Acrobat & Share 7 Comments

HE B

rét,g Ea = [m @S | B Get Agains ) %] J@ '4 e (S <) |:n+ %

New Reuse | Table | Pictures Screenshot Photo | Shapes lcons 3D SmartAt Chart | Forms | oy 00| Zoom Comment | Text Header WordArt Equation Video Audio Screen | Powtoon
Slide ¥ Slides - 5 v Abumv |~ Models O - Box &footer v 8] - v~ Recording | Export

Slides Tables Images llustrations Forms Add-ins Links Comments Text Symbols Media Powtoon oS

e e e N e N o P O W N W T NN N S
1 Powtoon Export > X
[
2 - .Z. Powtoon | Convert Presentations to Video & POWTOON
2 Launch the add-in

3

After you install the add-in, you can launch it by choosing the add-in button on the Insert tab

On the Insert tab

% EXPORTED SUCCESSFULLY

ponten

Open Powtoon

Need more help?

v v 1
‘RE“‘"’ . YDW%"(E”\@( e ‘m‘k i y:u"brcwsf;:b— 1b&ai=WA1043820018rs=en-US&ta=HE B-U a ﬂ ’) '] 1] LL ’% q ’) ’] ﬂ F] i EX p O rt

slides LRIARWILED

slide 10f3 [T}  English (United States)

E 5 8B F - 1 + 713% D

AUEANUITUIAAAIUMSANKINGIMERSAVIW (FIFD) ATUEIWNYAARSASS1BWE1Ua Tel. 02-4199978, 02-4196637



[ASIN1SoUSUIBIUAURA 1$09 Media creation tools for online courses 29 - 30 Mar 2021

lang: 8379 W81 LauQIugﬂ LUDD W INATINALLULAR B % bA7

® 15397%3170 Blank Slide
. Lﬁaﬂgﬂuuu Look NRBIN1TRIY

® 8319 Slide WHERITVUITVITWYDIAWBLAI 914724 5 slides 1o g
FINNIDLRaNLAT o U NA AU BTN T Ie LazA1Rwe LA
animation AMUAIVULAVUIEZRY

olAUUANRILITOBRILBLG RS Slide (A1LAT0INLTRINNTA
vufnigsale)
*789NA Preview LNGQHAIIUTDIAUIDY

85

NIIRIINU

*&4 link URL lulasing
Toh

® 841149 email: vorawan.van@mahidol.edu
30

®*Publish ‘fu Youtube lasvinn1s Export LLUyY HD 720p e
&9 link Youtube lulasingn w3a n19 email

A

115 AUEANUITUIAAAUMISANKINGIERSAVAW (FIFID) ATUEIWNYAARSASS1BWeUa Tel. 02-4199978, 02-4196637




[SIMSOUSUIBIUAURA 1500 Assessment workshop for clinical teachers 29 - 30 Mar 2021

ns=auuunn

m AUgAUITUIAAAUNMSANWINGIMARSIVATW (FIFID) ALUIWNGAIANSASS1BWEIUNa Tel. 02-4199978, 02-4196637



[SIMSOUSUIBIUAURA 1500 Assessment workshop for clinical teachers 29 - 30 Mar 2021

ns=auuunn

AUEANUITUIAAAIUMSANKINGIMERSAVNW (FIFD) ATUEIWNYAARSASS1BWEUA Tel. 02-4199978, 02-4196637 117




[SIMSOUSUIBIUAURA 1500 Assessment workshop for clinical teachers 29 - 30 Mar 2021

ns=auunn

m AUgAUITUIAAAUNMSANKINGIAMARSFVAIW (FFD) ALUIWNGATANSASS1BWEUNA Tel. 02-4199978, 02-4196637



[ASIN1SoUSUIBIUAURA 1509 Assessment workshop for clinical teachers 29 - 30 Mar 2021

QQsHEE Question & Comment

5Sirira) Health sclence Education Excellence center

AUgAMUITUIAAAUNISANYIINYIANENSIVNIW (FIFID)
Siriraj Health science Education Excellence center (SHEE)

91ANSASAISUNST Bu 3 (Ko 309)
ANUIWNYAIEASASS1IBWEIUIA
d10nvau 1avii 2 IIVOYASS1E IvAUINanUoy nsJINw4 10700

[nsans. 0 2412 3901
ANMO E - mail : sishee@mahidol.edu

‘ [nsfiwn. 024199978 02419 6637

AUEANUITUIAAAIUMSANKINGIMERSAVNW (FIFD) ATUEIWNYAARSASS1BWEUA Tel. 02-4199978, 02-4196637 m



